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Warranty

Please enter the serial numbers and date or dates of installation. Keep this manual
near the Hydra DT microdispenser for reference.

Serial Number Date Installed

Hydra DT base unit

2-Position or 3-Position X/Y Plate Stage

eDrop, Single-Channel Non-Contact
Nano Volume Dispenser

The Hydra DT microdispenser is warranted against defects in material and
workmanship for one year from the date of installation. Parts subject to normal wear,
such as syringes and PTFE® tips, are excluded.

Do not try to service or repair a Hydra DT microdispenser under warranty before first
contacting your equipment provider. See page 1-9 for contact information.

If service is required after the warranty period, it is still advisable to consult with your
equipment provider before performing the service task, especially when the repair
may be technically sophisticated or difficult.

If you need to return the microdispenser or parts of the microdispenser to Matrix
Technologies for any reason, you must do the following:

1. Contact your equipment provider and obtain return approval and a Return
Authorization Number. A decontamination form can be downloaded from
www.matrixtechcorp.com.

IMPORTANT: Fill out the IRR Form completely. Describe on the form what
applications the instrument has been used for and what materials have been
used with the instrument, including any hazardous chemicals, radioisotopes, or
biohazard materials. You must also describe how the instrument has been
cleaned and inspected prior to its return and list the name and number of the
person who performed the cleaning and inspection.

A Caution: Ensure that the completed IRR Form is included in the return package.

vi

Do NOT return the microdispenser or its parts without this completed form.
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. Do not return any of the accessories unless you believe there is a problem with
one of them.

. Package the instrument in its original packing materials. All equipment being
returned to the factory for any reason must be shipped in the original shipping
containers and packaging. If you do not have the original shipping containers and
package, you must purchase them and pack the merchandise in it. To order the
packaging, see the current price list at the Matrix Technologies website at
http://www.matrixtechcorp.com/.

. When you pack the unit, ensure that the syringe pistons are in the full down
position.

Ship the returned material by 2-day air service.

The contents of this manual may change as new features and accessories are added.
By mailing the self-addressed and postage-free Warranty Card that you received with
your Hydra DT microdispenser, you will receive updated information about the
microdispenser. Your comments and suggestions for improving the performance and
versatility of the Hydra DT microdispenser are always welcome and appreciated.

Warranty vii



luiel thinking.

Packing List

viii

The Hydra DT Base Unit Microdispenser (Item numbers: 109610, 109620, 109630,
109640, 109611, 109621, 109631, 109641, 109625, 109535, 109645, 138410,
138411) is supplied with these items:

(1) Operator’s Manual

(1) ControlMate Software CD

(1) Power Cord

(1) Emergency Shutoff Switch

(1) RS 232 cable

(1) Adapter for RS232 to 9 pin serial port

(1) Adapter for USB to serial port

(1 ea) Extra Fuses: 0.5 amp slow blow (for motor power supply); 3 amp; 1.6 amp

If your system includes the 3-Position X/Y Plate stage, these items are also included:

(1) 3-Position X/Y stage with connecting cables (nest and stage) (item #1096-DT-
XY3)

(1) 9/64 Allen wrench

(1) Phillips screwdriver

If your system includes an eDrop system, these items are also included:

(1) eDrop ™ single-channel dispenser fluidics component with power cord

(1) eDrop wash/aspirate module (attached to stage)

(1) Z-positioner for single-channel dispenser

(1) Tubing set for gas and liquid (includes 5/32-inch fitting and tubing for the
air-supply regulator.

(1) Replacement nano needles, set of 2

(1) Replacement nano tubing

(1) Serial cable, 9-pin

(1) USB adapter

(1) CD ROM with USB driver

If any of these items are missing when you first unpack your system, contact your
equipment provider.
See page 1-9 for contact information.
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Warnings and Cautions

Follow these instructions to shut down the system, ensure operator safety, and avoid < J[ - ‘[Formatted: Keep with next ]
damage to the microdispenser.

Stopping the System

«t-- ‘{Formatted: Keep with next, Keep J
WARNING! To shut down the unit IMMEDIATELY in case of an emergency, use lines together
the Emergency Shutoff Switch:

1. Firmly press the red button on the Emergency Shutoff Switch (see Figure i).

Figure i: Emergency Shutoff Switch
2. If you are running the system with the software, exit from the software.

3. To restore power to the microdispenser: First put an empty reservoir or plate
on the tray table or stage under the dispensing head. Then rotate the red button
in the clockwise direction, as shown on the arrows on the button. (When you
turn the system on, the syringe plungers will descend to their lowest point to
empty the tips and the tray table or stage will move down to the zero point.)

m To turn off the system when you are finished using it for the day:

1. Press the power switch on the rear of the Hydra DT microdispenser to OFF.
See Figure ii.

Figure ii: Power Module

4. If you are running the system with the software, Save and Close the Sequence
file and File- Exit to close the ControlMate interface. The computer can now
be shut down.

Warnings and Cautions ix
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Protecting the Operator

Caution: Before you perform any microdispenser service or maintenance task
that does not require you to run the microdispenser, turn the microdispenser off
by pressing the power switch to OFF. Then unplug the power cord.

Protecting the System from Damage

A

>B> B P

x

Caution: In general, do not allow the disposable tips to contact the bottom of
any plate, tube, reservoir, tray, or wash basin when you are filling, or emptying or
when you are setting tray table heights. The only time the tips need to touch the
bottom of the plate is when they are dispensing volumes of 3uL or less onto a dry
plate. For dispense volumes greater than 3pL, the size of the droplet formed on
the tip will be large enough to bridge the gap between the tip and the bottom of
the plate when the dispense height is set at 0.3mm back from touching the plate.
If the tips touch the plate during a dispense with volume greater than 3L,
backpressure will build up in the syringes, because the sample cannot exit the
tips as fast as the syringe plunger is pushing the sample out. That pressure can
damage the syringes. If a syringe is damaged during operation, turn off power to
the unit immediately by pressing the Emergency Shutoff Switch. See page 6-9
for more information about heights for small-volume dispenses.

Caution: Use a power strip with surge protection with the microdispenser.
Although the printed circuit board is protected, noisy AC lines can cause the unit
to behave erratically or can blow the fuse. The circuitry within the microdispenser
is sensitive to sudden voltage fluctuations that result from a surge in electrical
power. Those fluctuations can be common in facilities with older electrical
systems. They can also occur frequently during lightning storms.

Caution: Minimize or eliminate the use of appliances on the same electrical line
as the microdispenser. Fluorescent light power supplies (such as those used with
microscopes), high-current heaters, and cycling electrical motors used on the
same electrical line as this unit can cause the unit to behave erratically.

Caution: The printed circuit board might be charged with static electricity.
Ensure that you are properly grounded before you touch the printed circuit board.

Caution: Do not allow corrosive or oxidizing agents, such as chlorine bleach,
strong acid, etc., to be in continuous contact with the microdispenser. Such
agents can be used routinely with the Hydra DT microdispenser but may damage
the case, the tray table, and/or the glass syringes if left in contact with the
instrument for extended periods of time. If you need to use these reagents in a
protocol, ensure that you clean the microdispenser of any residual corrosive
agent as soon as you finish the procedure. If you need to use any strong
oxidizing or corrosive agent other than those listed in Table 6-9 on page 6-26,
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contact your equipment provider for assistance. See page 1-9 for contact
information.

Caution: On a Hydra DT system that includes the X/Y Plate Stage, do not allow
the stage to strike its X or Y stop points with excessive force. This may damage
the stage. Save the shipping plates and all screws. These plates are used to
keep the two motorized sections of the positioner immobile during shipment.

How to Use This Manual

This manual is both a user’s guide and a reference manual. You can read through the
manual from beginning to end to learn about the system and practice using it. You
will get an introduction to the Hydra DT microdispenser and then learn how to set up
the hardware, program file parameters, check system performance, service and
maintain the system, and use the system most effectively.

Chapters 3 and 4 contain “getting started” information. You can use them to practice
setting up files and running procedures.

You can also use the tables, diagrams, figures, procedures, and headings (as well as
table of contents and index) to access just the piece of information you need.

How to Use This Manual Xi
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Overview of the Hydra DT Microdispenser

The Hydra DT microdispenser from Matrix Technologies is an addition to the Hydra
line of bench-top microdispensers that provide high-speed aspirating and dispensing
into 96-well or 384-well microplates.

The Hydra DT uses DART (Disposable Automation Research Tips) disposable
magazines for quick, single-hand, tip loading. The tips in the rigid DART magazines
are sealed against a silicone pad on the underside of the pipetting head and locked in
place with an easy-grip handle. The pad forms an even and airtight seal that
minimizes tip-to-tip height variations and ensures consistent dispensing into all
microplate wells.

The Hydra DT base unit has a motorized platform (a “tray table) that moves up and
down (Z-axis movement), allowing you to position microplates and other labware
under the disposable tips. (If you add the optional X/Y Plate Stage to the base unit,
the tray table is replaced with a 3-position stage that moves in the X Y and Z
(L,R.F,B, Up) directions.

You can program the Hydra DT microdispenser to perform basic liquid transfer tasks,
including aspirate, dispense, mix, and empty, by using the touch pad or the
ControlMate software that is included with the basic unit. You can program the
positioning of the tray table or stage to move labware toward and away from the
pipetting head.

When you program the microdispenser using the touch pad, each program is stored in
one of 16 selectable files that reside on the microdispenser; no separate computer is
required.

If you are planning to use the included ControlMate software to create and run
programs, you will need to install it on your own computer, with the system running
under Microsoft® Windows® 95 or later operating system.

Introduction to the Hydra DT Microdispenser 1-1
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You can also use the communications protocol, provided in Appendix D, to integrate
the workings of the Hydra DT microdispenser into an automated laboratory.

Hydra DT Base Unit

The Hydra DT base unit microdispenser appears in Figure 1-1.

Up & Down Buttons
(for setting parameters)

File settings &

Operation Display Edit & Page Buttons or

Empty, Aspir, Wash &

Page Buttons

Tip Change Handle

Syringe Array
STOP Button

Dispense Button

Disposable Tips

Figure 1-1: The Hydra DT Microdispenser
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The Hydra DT with single stage and PC in Figure 1-2.

Hydra DT Microdispenser
Windows Laptop Computer

A k Emergency

Shutoff Switch

Figure 1-2: Hydra DT system

Optional Accessories

The 3-Position X/Y Plate Stage can be added to any Hydra DT base unit. It provides a
programmable stage for positioning microplates and other labware under the pipetting
head. See Figure 1-3. The Hydra DT with X/Y Plate Stage requires a computer with
ControlMate software for operation. Users must calibrate the stage, then program
stage positions for their laboratory protocols.

Figure 1-3: The 3-position X/Y Plate Stage

The eDrop single-channel nano-volume dispenser, complete with single-needle wash,
can be added to any Hydra DT system. The eDrop dispenser requires the purchase of
the 3-position X/Y Plate Stage accessory (1096-DT-XY3). See Appendix E for
setting up and using the Hydra eDrop System.

The ControlMate OLE ActiveX COM automation interface provides additional
functionality to the Hydra DT system. This interface was developed for use with
Microsoft Visual Basice versions 5 and 6.

Introduction to the Hydra DT Microdispenser 1-3
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Hydra DT Microdispenser Model Types

The Hydra DT microdispenser is available with a 96-well or 384-well pipetting head.

The ControlMate software is included with every Hydra DT unit.

Optional accessories for the base unit include the 96 to 384 manual plate positioner,
X/Y plate stage and eDrop module. An optional software component, ControlMate
OLE, provides an ActiveX®' COM automation interface.

Table 1-1 lists the base-unit models, and Table 1-2 lists the optional add-ons.

Table 1-1: Hydra DT Microdispenser Base Unit Models

with 384-channel 30ul and 100ul DARTs

Catalog No. Description Volume range Compatible tip types
1096-DT-100 | MY 96 DT-100 base unil sompatie | o.5uito 100ul | 5506, 5526, 5586
1096-DT-g00 | MY 96 DT-300 base uhll, compatble | 50,11 300ul | 5516, 536, 5546
1384-DT-100 | Hydra 384 DT-100 base unit, compatible |, 54, 100y | 5416, 5316, 5326

Table 1-2: Hydra DT Replacement Pipetting Heads

Hydra 384 DT-100

Catalog No. Description Volume range Compatible tip types
Ay Replacement pipetting head for the

1096-RH-100 Hydra 96 DT-100 0.5ul to 100ul 5506, 5526, 5586
AL Replacement pipetting head for the

1096-RH-300 Hydra 96 DT-300 5.0ul to 300ul 5516, 5536, 5546

1384-RH-100 | Reéplacement pipetting head for the 0.5ulto 100ul | 5416, 5316, 5326

Table 1-3: Optional Add-ons for Hydra DT Systems

Hydra DT Model Catalog No. Description

3-Position X/Y Plate 1096-DT-XY3 Programmable stage for positioning microplates and other

Stage receptacles the along X, Y, and Z-axes

eDrop, Single-Channel | 10961N1 Single-channel nano-volume dispenser. Requires

Non-Contact Nano purchase of X/Y Plate Stage accessory (10961XY2 or

Volume Dispenser 10961XY3).

ControlMate OLE 501-30023 ControlMate OLE ActiveX COM automation interface, to be

software component used with the ControlMate device-control software.
Developed for use with Microsoft Visual Basic® versions 5
and 6.

! Active X is a registered trademark of Microsoft Corporation.
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Syringe Design and Construction
The syringes manufactured for the Hydra DT microdispensers are specially designed
to facilitate reproducible, low-volume dispensing. The parts of the syringe setup are:

m  Glass syringe barrel: high-quality borosilicate glass, with inner chambers that are
precision-machined and highly polished to ensure leak-free performance

m Plunger: stainless steel

m PTFE plunger tip: fitted on the end of the plunger, with ribbing to prevent leaking
around the tip under pressure

The removable PTFE tips (for replacement when necessary) on the plungers are
included on all syringes.

See Appendix A for a tabular list of the syringe types. See Appendix B for
information about how to order replacement syringes and how to get syringes
refurbished.

Introduction to the Hydra DT Microdispenser 1-5
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DART Magazine Construction

The DART tips are designed to seal tightly against the plate head to ensure accurate
and consistent volume delivery. See Figure 1-4: DART Magazine Construction.

L L o L LT TL T T T T

LTLTLTT

TLELEL

Figure 1-4: DART Magazine Construction

Table 1-4: DARTSs types by Hydra DT unit
Hydra DT for 96-well, 100ul (1096-DT-100)

Catalog Description Type Volume Compatible Instruments
number range
100ul, 20 disposable magazines of 96 etar 0.5ulto |Hydra DT 96/100, PMP,
5526 per case Non-sterile 100ul PM2x2
5507 100ul, 20 disposable magazines of 96 Sterile 0.5ul to Hydra DT 96/100, PMP,
per case 100ul PM2x2
100ul, 20 disposable magazines of 96 | Filtered 0.5ulto |Hydra DT 96/100, PMP,
5528 f
per case sterile 100ul PM2x2
5586 30ul, 20 disposable magazines of 96 Non-sterile 0.5ul to Hydra DT 96/100, PMP,
per case 30ul PM2x2
5587 30ul, 20 disposable magazines of 96 Sterile 0.5ul to Hydra DT 96/100, PMP,
per case 30ul PM2x2
5588 30ul, 20 disposable magazines of 96 | Filtered 0.5ulto |Hydra DT 96/100, PMP,
per case sterile 30ul PM2x2
30ul Extended Length, 20 disposable ) . 1.0ul to Hydra DT 96/100, PMP,
5506 magazines of 96 per case Non-sterile 30ul PM2x2
5507 30ul Extended Length, 20 disposable Sterile 1.0ulto |Hydra DT 96/100, PMP,
magazines of 96 per case 30ul PM2x2
5508 30ul Extended Length, 20 disposable | Filtered 1.0ul to Hydra DT 96/100, PMP,
magazines of 96 per case sterile 30ul PM2x2
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Hydra DT for 96-well, 300ul (1096-DT-300)
Catalog Volume .
number | Description Type range Compatible Instruments
300ul, 20 disposable magazines of 96 ) 5.0ulto |Hydra DT 96/300, PMP,
5517 per case Sterile 300ul PM2x2
5518 300ul, 20 disposable magazines of 96 | Filtered 5.0ul to Hydra DT 96/300, PMP,
per case sterile 300ul PM2x2
300ul extended length, 20 disposable ) . 5.0ul to Hydra DT 96/300, PMP,
5536 magazines of 96 per case Non-sterile 300ul PM2x2
5537 300ul extended length, 20 disposable Sterile 5.0ul to Hydra DT 96/300, PMP,
magazines of 96 per case 300ul PM2x2
5538 300ul extended length, 20 disposable | Filtered 5.0ulto |Hydra DT 96/300, PMP,
magazines of 96 per case sterile 300ul PM2x2
300ul wide bore, extended length, 20 etari 5.0ulto |Hydra DT 96/300, PMP,
5546 disposable magazines of 96 per case Non-sterile 300ul PM2x2
5547 300ul wide bore, extended length, 20 Sterile 5.0ul to Hydra DT 96/300, PMP,
disposable magazines of 96 per case 300ul PM2x2
5548 300ul wide bore, extended length, 20 | Filtered 5.0ulto |Hydra DT 96/300, PMP,
disposable magazines of 96 per case | sterile 300ul PM2x2
Hydra DT for 384, 100ul (1384-DT-100)
Catalog Tvpe Volume Compatible
number |Description yp range Instruments
5416 30ul extended length, 20 disposable |\ |6 5,110 30y | HYdra DT 3847100, PMP,
magazines of 384 per case PM2x2
30ul extended length, 20 disposable . Hydra DT 384/100, PMP,
5417 magazines of 384 per case Sterile 0.5ul'to 30ul PM2x2
5418 30ul exjended length, 20 disposable Filtgred 0.5ul to 30ul Hydra DT 384/100, PMP,
magazines of 384 per case sterile PM2x2
30ul, 20 disposable magazines of atari Hydra DT 384/100, PMP,
5316 384 per case Non-sterile | 0.5ul to 30ul PM2x2
30ul, 20 disposable magazines of . Hydra DT 384/100, PMP,
5317 384 per case Sterile 0.5ul to 30ul PM2x2
30ul, 20 disposable magazines of Filtered Hydra DT 384/100, PMP,
5318 384 per case sterile 0.5ul'to 30ul PM2x2
5326 100ul, 20 disposable magazines of Non-sterile | 1.0ul to 100ul Hydra DT 384/100, PMP,
384 per case PM2x2
5307 100ul, 20 disposable magazines of Sterile 1.0ul to 100ul Hydra DT 384/100, PMP,
384 per case PM2x2
100ul, 20 disposable magazines of | Filtered Hydra DT 384/100, PMP,
5328 384 per case sterile 1.0ulto 100ul PM2x2

When a wash sequence using the Wash Pump Module is started, Fill pump 1 fills the
Wash Reservoir, and then the tray table or stage rises. On a system without the stage,
the tips pass through slots in the tray table and into the reservoir. On a system with
the stage, the stage moves away from the front of the microdispenser so that the top

Introduction to the Hydra DT Microdispenser
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Related Products

Matrix Technologies products that you might use with your Hydra DT
microdispenser system include:

Table 1-3: Related Products

Product Description
TrakMates® 2-D Barcoded Tubes
V-Groove Automation Reservoirs 96, 96-Deep, 384
Reservoirs 8 or 12-Channel
ScreenMates® 96, 384, 1536 Well Plates
Tube Chiller 1 and 3-Position

For more information about these and other Matrix Technologies products, contact
your equipment provider (see page 1-9 for contact information) or visit
http://www.matrixtechcorp.com. See Appendix B for more information about
Hydra DT microdispenser replacement parts and accessories.
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Contact Us with Questions and Comments

Send us the self-addressed, postage-paid Warranty Card included with the Hydra DT
microdispenser to receive updated information about your Hydra DT microdispenser
system.

Your comments and suggestions for improving the performance and versatility of the
Hydra DT microdispenser system and this manual are always welcome and
appreciated.

If you have any questions or comments about your Hydra DT instrument, contact
your equipment provider. Some of those contacts are listed on this page. If your
instrument was provided by a distributor not listed here, contact Matrix Headquarters.

Corporate Headquarters German Office
22 Friars Drive Vogelsangstrasse 12
Hudson, NH 03051, USA D-61273
Toll free: (800) 345 0206 Wehrheim, Germany
Tel: (603) 595 0505 Tel: +49 6081 981878
Fax: (603) 595 0106 Fax: +49 6081 981959
Email: info@matrixtechcorp.com

Swiss Office
European Headquarters Seedammstrasse 3, Postfach
Lower Meadow Road CH-8808, Pfaffikon SZ
Brooke Park Tel: +41 55 417 4546
Handforth, Wilmslow Fax: +41 55 417 4647
Cheshire SK9 3LP, UK
Freefone: 0800 389 4431 Asia-Pacific Office
Tel: +44 161 486 2110 Japan
Fax: +44 161 488 4560 Email: asia@matrixtechcorp.com

Email: info@matrixtechcorp.eu.com

French Office

15 Rue Des Pas Perdus
95804 Cergy Saint Christophe
BP83338 France

Tel +33-134-2544-42

Fax +33-134-25-44-00

Introduction to the Hydra DT Microdispenser 1-9
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Prepare the Site
1. Clear adequate space on your workbench for the microdispenser and all other

2

system components.

Ensure that the setup allows the microdispenser to be plugged into a surge
suppressor and that electrical noise is reduced or eliminated. Electrical noise
generated by appliances such as fluorescent lights, motors, and heaters can cause
the microdispenser to behave erratically and can even damage the microdispenser.

Note: If your system includes a Hydra eDrop module, see Appendix E for setup
information.

Unpack the Microdispenser

1.
2.

A

Make sure that the box or boxes are right side up.
Carefully open each box and remove any foam packing surrounding the pieces.
Caution: Do NOT grasp the microdispenser by the pipetting head handle. Grasp

it by placing one hand firmly on either of its sides, with your fingers in the finger
slots, and then slowly lift it straight up out of the box.

Lift all pieces out of the box or boxes and gently place the pieces on the
workbench, with the front of the microdispenser facing you.

Check the contents of the box or boxes against the packing list. Contact your
equipment provider if pieces are missing. See page 1-9 for contact information.

Setting up the Hardware 21
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Moving the Microdispenser

Caution: Always place your fingers in the finger slots, one on each side of the
microdispenser, before you lift the instrument to move it. Do NOT grasp the
microdispenser in any other way before you move it. If your system includes the
stage, NEVER lift the system by the stage.

Note: If your system includes the stage and you have already attached and
calibrated the stage, you will need to check the calibration and possibly
recalibrate the stage after you move the system. (Instructions for calibrating the
stage begin on page 4-21.)

Set Up the Stage (Hydra DT with X/Y Plate Stage Only)

Have these items available:
m  Allen wrench for hex screws (provided with system)

m Phillips screwdriver

1. Place the X/Y Plate Stage so that the two holes in the mounting bracket align with
the two pins in the mounting plate on the Hydra DT microdispenser. Secure the
stage to the microdispenser with the 4 hex screws using the Allen wrench.

See Figure 2-1.

Insert 4 mounting screws. |

Figure 2-1: Mounting Stage onto Microdispenser

2. Gradually tighten each screw so that uniform tension is applied. Do not over
tighten.

2-2
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3. Remove the metal shipping plates on the front and side of the stage with a
Phillips-head screwdriver. (See Figure 2-2.) The stage should now move easily
side to side and in and out.

Figure 2-2: Removing Shipping Plates

A Caution: Do not allow the stage to strike its X or Y stop points with excessive
force. Such strikes might damage the stage. Save both shipping plates and all
screws. These plates are used to keep the two motorized sections of the stage
immobile during shipment.

4. Change base module to the X Y Stage on the STOP/PAGE screen.
See “Configure XY stage” on page 2-7.

Change the Voltage Setting for the Microdispenser If
Necessary

The microdispenser can operate on either 115-volt power or 230-volt power. You can
change the setting, if necessary, as follows:

Have these items available before you begin:

m Flat blade screwdriver

m  Two fuses for the voltage you will be using (115V or 230V)

1. If the system is already connected and plugged in: Turn off power to the system
and then unplug the power cord from the back of the system and from the surge
SUppressor.

2. Put the tip of the screwdriver in the small slot at the top of the power module on
the back of the microdispenser and gently pry open the cover on the power
module.

Setting up the Hardware
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Slot for removing
fuse cover

Figure 2-3: Power Module

3. Put the tip of the screwdriver in the slot at the top of the red square (the end of the
fuse box) and gently pry the fuse box end away from the microdispenser until you
can grasp it with your fingers.

Slot for removing ==

e ;
fuse cover : \

Figure 2-4: Removing the Fuse Box
4. Pull the fuse box out and remove the two fuses.

Insert the new fuses.

screwdriver to gently push the silver metal tab inside the fuse space toward the
end of the fuse box. Sometimes the tab is bent slightly toward the middle of the
box, and that tab placement can keep the 230 fuses from being correctly
inserted.

z Note: If you are inserting 230 fuses, you might need to use the end of the

6. Re-insert the fuse box in the power module with the number for the voltage you
are using (for example, 115V) right side up so that you can read it.

2-4
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Figure 2-5: Inserting the Fuse Box With 115V Setting
7. Close the power-module cover.

8. If the system was already connected and plugged in: Plug the surge suppressor
into the new power source, and then plug the power cord into the system and into
the surge suppressor.

Connect Power Cords and Cables; Turn On the System

1. Plug one end of the power cord into the power module on the rear of the unit.
See Figure 2-6.

Ethernet RS232

EMERGENCY
STOP.

Stage .

WARNIG - o Continne Protecton
Aginst Fire, Replace Gy
With Same Type and Ratng

fise.

Power Module Power Switch

Power Input

Figure 2-6: Back of Microdispenser

2. Plug the other end of the cord into a surge suppressor.

Setting up the Hardware

Emergency Shutoff Switch
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microprocessors used to control the unit.

Caution: You must use a power strip with a surge protector to protect the
A Install the Emergency Shutoff Switch.

you to operate the unit. The unit will not operate without the
switch.

z Note: The Emergency Shutoff Switch must be installed for

a. Plug the connector on the cable of the Emergency
Shutoff Switch into the receptacle on the back panel of
the microdispenser. See Figure 2-7.

b. Secure the cable by turning the connector clockwise.

Figure 2-7: Attaching E-stop plug

is on the tray table/stage directly underneath the syringe head. When the
system is powered on, the tray table or stage will move to its lowest (Z-axis
down) position, and then the syringe plungers will automatically move to the
empty position (plungers down), and the syringes will empty.

z Note: Before you turn the system on, ensure that an empty reservoir or plate

c. Test the Emergency Shutoff Switch: Press the red button on the switch to turn
it ON. (See Figure 2-8.) Press the power switch on the back of the micro-
dispenser to turn the system ON. Then press the red button on the switch to
shut the system OFF. Restart the system by rotating the red button in the
clockwise direction, as shown by the arrows on the button.

Figure 2-8: Emergency Shutoff Switch

5. If the stage is part of your system, connect the stage cable between the
computer and the STAGE connection on the back of the microdispenser.

2-6
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Configure hardware options

The XY stage and the wash pump module are both optional accessories; therefore the
Hydra base unit must be appropriately configured to work with them. See the
following sections.

Configure XY stage

1. Press and hold the STOP button, then press the PAGE button to display the
following screen.

Tupes Cordig
Flme = 04  #Y = ljlrfd
Ll

Hudra Tupe = 1668
Edit Cory Fade

2. Press the EDIT button to scroll to the XY setting.
3. Press the UP or DOWN (A V) buttons to toggle the XY stage option on and off.

4. After configuring your Hydra system, press the PAGE button to exit the set up
screen. You will see the following screen.

e — T
Traw=08 1vicC 3FIC

Sur =@ 171C 371C
Surle SurHome ESC

5. Press the ESC button to return to the main screen.

Setting up the Hardware

2-7



5 MATRIX

luiel thinking.

Connect the Computer
(If You Added a Computer to Your System Setup)

If you are using your own Windows computer to run the ControlMate software,
connect the computer to the back of the microdispenser with the components in
Figure 2-9 in the following sequence:

1.

2
3
4.
5. Ethernet cable to Hydra DT

To

Computer == = @

Computer to USB cable

USB cable to serial port adapter
Serial port adapter to Ethernet adapter
Ethernet adapter to Ethernet cable

To

P 1A
o - Hydra DT

USB Cable USB Adapter Ethernet Adapter Ethernet Cable

Figure 2-9: Communication cables and adapters Miscellaneous Hardware Tasks

(Optional)

2-8

If you are using ControlMate OLE software for your system to install it on your
own Windows computer, see “1. Install ControlMate software if it is not already
installed” on page 4-4.

If you want to connect your microdispenser to a computer in your workplace to
automate some microdispenser functions, see Appendix D, “Integrating the
Hydra DT Microdispenser System into an Automated Laboratory.”

If you are interested in finding out whether you can change the syringe size on
your Hydra DT microdispenser to another size, contact your equipment provider.
See page 1-9 for contact information.
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3: Getting Started: Manual Operation
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Two Operation Methods

The two operation methods for creating and editing files and running procedures on
the Hydra DT microdispenser are:

m  Manual Operation—Use buttons on the front of the micro-dispenser to edit
EPROM files (up to 16) that contain settings for Dispense, Aspirate, Empty, and
Wash operations. Then use buttons, also on the front of the microdispenser, to
execute those operations. The files are automatically saved on the microdispenser.
No computer interface is needed.

m  Automated Operation—Use ControlMate software installed on the Windows
computer to calibrate labware and create, edit, run and save “sequence files”
(pipetting programs). If your system includes the 2-Position X/Y Plate Stage, you
also use the software to calibrate the stage.

This chapter describes the Manual Operation method. Chapter 4 describes the
Automated Operation method.

Note: You can use both methods on a system that includes a Windows computer
with ControlMate software. If your system setup does NOT include the computer
and software, then you will use the Manual Operation method exclusively.

Getting Started: Manual Operation 3-1
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Steps for Learning Manual Operation of the Hydra DT

Microdispenser

The following flowchart shows the steps this chapter will walk you through to learn
how to use the Manual Operation method.

Study SAFETY
instructions

!

Look at
flowcharts of
Hydra interface
(Diagram 3-1)

¢

Read table of
file parameters
(Table 3-1)

v

Set tray table/
stage height
(Procedure 3-1)

!

Set file
parameters
(Procedure 3-2)

Run a
procedure
(Procedure 3-3)

|

Map layout of
microdispenser
buttons
(Figs. 3-1,2,3)

}

Read table of
microdispenser
operations
(Table 3-2)

1. Study the SAFETY Instructions

Review all Warnings and Cautions for use of the Hydra DT microdispenser,
starting on page ix.

2. Look at flowcharts of Hydra DT interface
Diagram 3-1 shows the screens that you will see, in this order, in each of the 16

files stored on the microdispenser. You do not have to “save” the files, because
the changes you make to the settings are automatically saved as you make them.

3-2
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Diagram 3-1: Hydra DT Interface

READY MODE
Syringe Format,
Current Volume,
& File Number®

A

(on ready mode screen)
FILE
Select File
1to 16

—

DISPENSE
Select DVol. Table**

height, Speed
~————

!

ASPIRATE
Select Prime, AVol,
Air Gap, Table**
height, Speed

To run the file, return to
the ready mode screen

EMPTY
Select Table**
height, Speed

Legend

*Firmware Version is shown on
display when you first turn the
system on, in the format “Vxxx”
where xxx = Numerals of version
number, no decimal pt. separator;
e.g., V 408 = Version 4.08.

**Table height = Stage height on
systems with X/Y Plate Stage.

\4

CHANGE DARTS
TIP MAGAZINE

Select DART type
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3. Read the table of file-parameter definitions and values

Table 3-1 lists the allowable values for the parameters you will set in your files.

2

one file to run your procedure.

Table 3-1: Hydra DT File Parameters

Note: Each file can only contain one instance of a particular parameter. If your
procedure requires multiple instances of an operation (Aspirate, for example)
with different values for the different instances, you will need to use more than

Screen Parameter | Possible Values Description
Ready Mode | File 1-16 File number.
DISPENSE Vol 100uL: 0.1 — 110 Dispense Volume. Volume of air or solution to
290uL: 0.5 — 290 dispense. Increases or decreases by 0.1/0.5/1.0uL
(varies with syringe size).

Table 0-3970 Dispense Height. Height of tray table/stage when
solution or air is dispensed. Increases or decreases
by 10 units.

Speed 1-5 Speed. 5 pre-set speeds for syringe-plunger motor.

ASPIRATE Prime ON/OFF Prime. A pre-set* (not user-selectable) volume of air
or solution will be aspirated and then dispensed
back into source plate. Primes syringes before
dispense. (*Pre-set volume is 5% of total syringe
volume.)

Vol 100pL: 0.1 - 110 Aspirate Volume. Volume of air or solution to

290pL: 0.5 — 290 aspirate. Increases or decreases by 0.1/0.5/1.0uL
(varies with syringe size).
Air 100uL: 0 - 110 Air Gap. Volume of air to draw into syringes before
290pL: 0 — 290 aspiration. Increases or decreases by 1.0. See page
6-5 for information about when to use an air gap.

Table 0-3970 Aspirate Height. Height of tray table/stage when
solution or air is aspirated. Increases or decreases
by 10 units.

Speed 1-5 Speed. 5 pre-set speeds for syringe-plunger motor.
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4. Map the microdispenser buttons

The buttons on the microdispenser will become familiar to you quickly. Here’s the
layout, to get you started:

Empty Aspr Wash Page

Figure 3-1: Buttons on Operation Screens
(Screens = Empty, Aspirate, Page, and Edit)

Down

Edit Page

Figure 3-2: Buttons on Ready Mode Screen

STOP

Figure 3-3: Buttons on Either Side of Syringe Array (STOP and Dispense)

Getting Started: Manual Operation
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5. Read the table of microdispenser operations

Table 3-2 describes how to use the microdispenser buttons.

Table 3-2: Hydra DT Microdispenser Operations

Operation/ Button

Description

V¥ [Down]

Press Down to decrease values for selected parameter (selected parameter
appears on top line of screen).

A [Up]

Press Up to increase values for selected parameter (selected parameter
appears on top line of screen).

Empty

To start operation: Ready Mode screen must be displayed, with current
syringe volume appearing in display. [Caution: If “Volume ??” appears on
Ready Mode screen, always empty the syringes before proceeding with any
other operation.] Press Empty to start Empty operation. Tray table/stage
rises and syringes empty. Volume shown in display is updated and tray
table/stage returns to home position. To interrupt operation, press STOP.
Tray table/stage returns to home position.

Aspr

To start operation: Ready Mode screen must be displayed, with current
syringe volume appearing in display. Press Aspr to start Aspirate operation.
If Prime is set to ON, a pre-set (default) “overshoot” volume* is aspirated and
then dispensed back into the source plate. (*Overshoot volume is 5% of
syringe volume). If Air is set, an air gap (volume of air) is aspirated into
syringes. Tray table/stage does not move when Air is aspirated. Tray
table/stage rises and Vol is aspirated. Volume in display is updated and tray
table/ stage returns to home position. To interrupt operation, press STOP.
See the discussion beginning on page 6-2 for detailed information about
when to use Prime (“Prime” is called “Overstroke” in ControlMate software)
and when to use Air.

Page

Press Page to scroll through screens of a file (screens are in a continuous
loop).

Edit

Press Edit to move from one parameter in a screen to next parameter in
same screen. Selected parameter appears on top line of screen.

STOP
(to left of syringe array)

Press STOP to stop current operation.

DISP
(to right of syringe array)

To start operation: Ready Mode screen must be displayed, with current
syringe volume appearing in display. Press DISP to start Dispense operation.
Tray table/stage rises and Vol is dispensed. Volume in display is updated
and tray table/ stage returns to home position. To interrupt operation, press
STOP.

Now that you have learned how to use the buttons, you can practice setting tray table
heights. Although setting tray table heights is part of the general practice of setting
file parameters, it is introduced separately here so that you can practice this technique
before setting up the rest of a file.
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6. Set up a tray table/stage height

Most microdispenser operations (Dispense, Aspirate, Empty) include movement of
the tray table/stage. Therefore, it is very important that you know how to set the tray
table/stage heights for those operations so that neither operator nor instrument is at
risk when the microdispenser is operating.

Caution: In general, do not allow the tips to contact the bottom of any
plate, tube, reservoir, tray, or washbasin. The only time the tips need to touch
the bottom of the plate is when they are dispensing volumes of 3L or less onto a
dry plate. For dispense volumes greater than 3pL, the size of the droplet formed
on the tip will be large enough to bridge the gap between the tip and the bottom
of the plate. In such cases, set the dispense height at 0.2 — 0.3mm back from
touching the plate. If the tips touch the plate during a dispense with volume
greater than 3L, back-pressure will build up in the syringes, because the sample
cannot exit the tips as fast as the syringe plunger is pushing the sample out. That
backpressure can damage the syringes. If a syringe is damaged during
operation, turn off power to the unit immediately by pressing the
Emergency Shutoff Switch.

You can find out more about setting optimum dispense heights in Chapter 7, starting
on page 6-9.

The following procedure describes how to set the syringes to a “near bottom”
position.

Have two microplates or reservoirs available for the procedure.

Procedure 3-1: Set the tray table/stage height

lowest (Z-axis down) position, and then the syringe plungers will automatically
move to the empty position (plungers down) and the syringes will empty.

z Note: When the system is powered on, the tray table or stage will move to its

1. Place an empty reservoir or plate on the tray table or stage directly under the
dispensing head, for the syringes to empty into.

2. Press the power switch on the back of the microdispenser to ON.

3. After the syringes have emptied, remove the reservoir or plate from the tray table
or stage.

4. Place an empty plate (“plate” = plate or reservoir) on the tray table or stage under
the dispensing head.

Getting Started: Manual Operation
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5. On the Ready Mode screen: press Up until File 14 appears in the middle of the
screen.

Ready Mode screen with File 14 selected
6. Press Page. The Dispense screen appears.

7. On the Dispense screen: Press Edit until Table is on the top line of the screen.

Dispense screen with Table parameter selected

8. Press Up to move the table/stage up until the tips are just touching the bottom of
the wells in the plate.

9. With your fingertips, gently tilt up the front edge of the plate, off the table/stage
and toward the tips. If the plate lifts easily, the tips are not at near bottom. Repeat
pressing Up (slowly) and testing closeness until you cannot lift the plate.

10. Press Down 2 or 3 times to bring the table/stage down slightly.
You have now set the Dispense Table (height) to a near-bottom position.

11. Press Page 5 times, to cycle back to the first Ready Mode screen in the file.

3-8
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7. Set file parameters

Procedure 3-2, following, is an exercise that leads you through setting parameters in a

file.

Before you start

1.
2.

A

Ensure that the Emergency Shutoff Switch is placed where you can reach it easily.

Review these Cautions before starting to set file parameters:

If a syringe is damaged, turn off power to the unit immediately by pressing
the Emergency Shutoff Switch. See page 6-9 for more information about
setting dispense heights for small-volume dispenses.

Procedure 3-2: Set file parameters

1.

5.
6.

Place one of the empty reservoirs or plates on the tray table or stage directly under
the dispensing head, for the syringes to empty into.

On the rear of the microdispenser, press the power switch to ON.

Note: *Firmware Version is shown on the display when you first turn the system
on, in the format "Vxxx" where xxx =Numerals of version number, no decimal
point separator; e.g., V515 = Version 5.15.

After the syringes have emptied, remove the first reservoir from the tray table or
stage and place the second empty plate (“plate” = plate or reservoir) on the tray
table or stage under the dispensing head.

On the Ready Mode screen: Press Up until File 14 appears in the middle of the
screen.

Ready Mode screen with File 14 selected

Press Page. The Dispense screen appears.

On the Dispense screen: If Vol is not on the top line of the screen, press Edit until
it is. Press Up or Down to set vol.

Getting Started: Manual Operation
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Dispense screen with Vol set to 10.0

Press Edit until Table is on the top line. Set Table to 3500 by pressing Up or
Down.

8. Press Edit until Speed is on the top line. Press Up or Down to set Speed to 5.

10.

11.

12.

13.
14.
15.
16.

3-10

Press Page. The Aspirate screen appears.

On the Aspirate screen: Press Edit until Prime is on the top line of the screen. If
Prime is set to OFF, press Up or Down to toggle it to ON. (See the discussion
beginning on page 6-8 for information about when and how to use Prime.)

Aspirate screen with Prime set to ON

Press Edit until Vol is on the top line. Press Up or Down to set Vol to 50.0/170.0
(varies with syringe size).

Press Edit until Air is on the top line. Press Up or Down to set Air to 0. (See
page 6-9 for information about when to use an air gap.)

Press Edit until Table is on the top line. Press Up or Down to set Table to 2700.
Press Edit until Speed is on the top line. Press Up or Down to set Speed to 5.
Press Page. The Empty screen appears.

On the Empty screen: If Table is not on the top line of the screen, press Edit to
put it there. Press Up or Down to set Table to 2500.
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Empty screen with Table set to 2500
17. Press Edit until Speed is on the top line. Press Up or Down to set Speed to 5.

9. Run a procedure

Before you start
1. Review these Warnings and Cautions:

WARNING! To shut down the unit IMMEDIATELY in case of an emergency,
press the red button on the Emergency Shutoff Switch.

Figure 3-4: Emergency Shutoff Switch

strong acid, etc., to be in continuous contact with the microdispenser. Such
agents can be used routinely with the Hydra DT microdispenser but may damage
the case, the tray table, and/or the glass syringes if left in contact with the
instrument for extended periods of time. If you need to use these reagents in a
protocol, ensure that you clean the microdispenser of any residual corrosive
agent as soon as you finish the procedure. If you need to use any strong
oxidizing or corrosive agent other than those listed in Table 6-9 on page 6-26,
contact your equipment provider. See page 1-9 for contact information.

é Caution: Do not allow corrosive or oxidizing agents, such as chlorine bleach,

Getting Started: Manual Operation 3-11
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Caution: Ensure that the tips are in the down position before you begin any
microdispenser operation (Aspirate, Dispense, Wash, or Empty). Having the
guide down ensures that each needle is aligned over the center of a well in the
microplate on the tray table. If the guide is not down and you start an operation,
some of the needles might get bent.

Caution: In general, do not allow the tips to contact the bottom of any
plate, tube, reservoir, tray, or wash basin when you are filling, emptying, or
washing the syringes or when you are setting tray table heights. The only time
the tips need to touch the bottom of the plate is when they are dispensing
volumes of 3L or less onto a dry plate. For dispense volumes greater than 3L,
the size of the droplet formed on the tip tip will be large enough to bridge the gap
between the tip and the bottom of the plate when the dispense height is set at
two to three clicks back from touching the plate. If the tips touch the plate during
a dispense with volume greater than 3L, backpressure will build up in the
syringes, because the sample cannot exit the tips as fast as the syringe plunger
is pushing the sample out. That pressure can damage the syringes. If a syringe
is damaged during operation, turn off power to the unit immediately by
pressing the Emergency Shutoff Switch. See page 6-9 for more information
about heights for small-volume dispenses.

Review Table 3-2, on page 3-6; it describes how to use the microdispenser
operation buttons.

Have the following labware and solutions ready:

- 1 empty reservoir, to empty the syringes into

- 5 empty plates or reservoirs (1 is a source plate and 4 are receiving plates)

- dH,O if you wish to run the procedure with solution (You can run it without
any solution.)

If the Wash Pump Module is part of your system setup, ensure that the wash

containers have water in them if you wish to use solution in the test run.

Procedure 3-3: Run a procedure

1.

Ensure that the Emergency Shutoff Switch is placed where you can reach it easily.

2. If the system is turned off, place an empty reservoir on the tray table or stage

L f
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under the dispensing head, and then turn the system on by pressing the power
switch to ON. Remove the reservoir after the syringes have emptied.

Note: *Firmware Version is shown on the display when you first turn the system
on, in the format "Vxxx" where xxx = Numerals of version number, no decimal
point separator; e.g., V515 = Version 5.15.

Access File 14, our exercise file. Press Page to cycle through the file-parameter
settings for the file to ensure that they are correct. Change settings if necessary.



Table 3-3 shows the settings that you entered in File 14, if you stepped through
Procedure 3-2. If you did not do that exercise, you can enter these settings in File 14

now.

Table 3-3: Parameter Values Entered in File 14

Screen Parameter Setting
Ready Mode File 14
Dispense Vol 10.0/40.0/70.0/120.01
Table 3500
Speed 5
Aspirate Prime ON
Vol 50.0/170.0/290.0/
Air 0
Table 2700
Speed 5
Empty Table 2500
Speed 5
Speed 5
Pumps3 P1 15
P2 15

luiel thinking.

4. If the system was already turned on when you began this procedure, now place an

empty reservoir on the tray table/stage, under the dispensing head and then, in

File 14, press Empty.

5. Remove the reservoir from the tray table/stage and replace it with the source
reservoir or plate, one that either contains dH2O or is empty.

6. Press Aspr. The syringes aspirate and dispense the Prime amount and then

aspirate the Vol amount of dH2O (or air).

7. Remove the reservoir/plate from the table/stage.

8. Place the first receiving plate onto the table/stage.
9. Press Dispense. The Vol of dH2O or air is dispensed into the plate/reservoir.

10. Repeat Steps 9 through 11 three times.

11. Remove the last receiving plate with the source plate.

12. Press Empty.

Getting Started: Manual Operation
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Two Operation Methods

The two operation methods for creating and editing files and running procedures on
the Hydra DT microdispenser are:

= Automated Operation—Use ControlMate software installed on the Windows
computer to calibrate labware and create, edit, run and save “sequence files”
(which are programs). For a Hydra DT with X/Y Plate Stage system, you also use
the software to calibrate the stage.

m  Manual Operation—Use buttons on the front of the micro-dispenser to edit
EPROM files (up to 16) that contain settings for Dispense, Aspirate, Empty, and
Wash operations. Then use buttons, also on the front of the microdispenser, to
execute those operations. The files are automatically saved on the microdispenser.
No computer interface is needed.

This chapter describes the Automated Operation method. Chapter 3 describes the
Manual Operation method.

and software, then you will use the Manual Operation method exclusively.

Note: If your system is an eDrop System, see Appendix E for information on
operating that system. It uses eDrop control software.

Note: You can use both methods on a system that includes a Windows computer
with ControlMate software. If your system setup does NOT include the computer

Getting Started: Automated Operation 4-1



5 MATRIX

luiel thinking.

ControlMate Online Help contains much of the information contained in this
chapter, so you can refer to the help system directly while you are using the
software. To access online help, do one of the following (italicized terms are
defined in the overview later in this chapter):

Click the Help icon in the Toolbar.

File Edit Y“iew Bun Toolk Addlns ‘Wwindow Help

‘Dﬁ‘r|ﬂ|%..|}<_|ﬂddﬁommand 'Hlﬁ|m‘|z)

Select a help item from the Help menu in the Menu Bar.

File Edit Wiew Bun Tools Addlns ‘Windowd Help

Click the Help button in any child dialog or command screen you are in.

Help |

4-2
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Steps for Learning Automated Operation of the
Microdispenser

The following flowchart shows the steps this chapter will walk you through to learn
how to use the Automated Operation method.

YES

2. Study SAFETY
instructions

ControlMate
installed?

NO

A

overview

3. Read software

configuration

6. Create labware

1. Install software

4. Check software _,,—» YES
NO

A

5. Calibrate the

stage

7 Create and Edit >
a sequence file

8. Run a sequence
file
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1. Install ControlMate software if it is not already installed
If you need to install the ControlMate software on your own Windows computer, or
are installing an upgrade, follow these instructions:
1. Set up the computer close to the microdispenser.
2. Insert the software CD in your CD drive.
3. If the installation does not start automatically, follow these steps:
From the Windows Start menu, click Run.
b. In the Open field on the Run dialog, type:
<your_CD_drive_letter>:hydra.exe
c. Click OK.
4. Follow the installation instructions given on the screen.

5. When installation is finished, restart your system.

2. Study the SAFETY instructions

Review all Warnings and Cautions for use of the Hydra DT microdispenser, starting
on page ix.

3. Read the overview of the software

ControlMate is a Windows PC application that provides a graphical programming
interface for creating and executing device module control programs. The
configuration defines the device module in use. The device module described in this
manual is the module for the Hydra DT Microdispenser.

The ControlMate overview on the next few pages describes:

m  The Main Application screen elements:
- Menu Bar
- Toolbar
- Toolbox
- Status Bar

m  The ControlMate command groups

m  The ControlMate “child dialogs,” which are the screens that allow you to perform
actions within the software

The rest of this chapter, after the overview material, describes how to use the
ControlMate tools to calibrate the stage (on Hydra DT with X/Y Plate Stage systems),
create labware, and create and run programs (programs are called “sequence files” in
ControlMate software).
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The Main Application Screen
When you start the ControlMate software, the Main Application screen opens. All of
the actions you take with the software will be executed with the Main Application

screen open.

¢ Matrix Technologies Corp - ControlMate ®
Eile Edit View Run Tools Add-Ins Window Help

|D@|==|¥Jh“|><_|ﬁddﬁommand vl|&|.l|g|’¢)

Toolbox

Menu Bar =
Tool Bar

i

Procedure External

L

Aspirate  Dispense

Toolbox ?‘I S ?

Mave Home

3 =i

Pump Speed

T-1

Change

Status Bar == |Dpen files (1) | |Aut0 conect: On | 4

Menu Bar
Select software operations, such as “Open Sequence File,” from the Menu Bar at the
top of the Main Application window.

(e Edit View Run Took Addins Window Help
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Table 4-1: Operations in the Menu Bar

Menu Function Purpose
Fil New Sequence Create a new sequence. Open (to view, edit, or run) an
e Open Sequence existing sequence.
Cut, copy, paste, and delete commands from sequence
Edit C.Ut Copy Paste Delete files. View the Clipboard to see what is currently on the
View Clipboard X
Clipboard.
Vi Toolbox Text View text labels for icons in the Toolbox. Select size for
iew . . A
Toolbox icon size the Toolbox icons.
Run Validate File Start Validate command parameters. Open the Execution
program to run a procedure.
Set communications parameters. View individual
Options Connection command settings. View default command-parameter
Tools Commands Limits limits. Set positions for stage locations. Create, add,
Positions Plates Motors | modify, and delete labware. Change the speed of the x,
y, and z axes motors.
Set Device and Pipettor | Choose device type (Base model Hydra DT; 3-Position
Add-Ins . - : .
Options X/Y stage positioner) and syringe size/volume.
T!Ie Hor|_zontally Arrange multiple open windows horizontally. Arrange
) Tile Vertically . : : ’
Window Cascade multiple open windows vertically. Arrange multiple open
Arrange Icons windows in overlapping cascade. N.A.
Help Contents Search About I_-Ielp tpplcs listed in table of confcents format. Help topics
listed in Index format. Help version.
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Toolbar

Click icons in the Toolbar to start software operations, such as “Open Sequence File.’
The Toolbar offers easy access to the Menu Bar’s most frequently used functions.

i

File Edit Wiew Bun Toolz Adddns  Window Help

D@ HE s Bmm Xaacomnd  Fl|[&R 5| &) 2

Table 4-2: Operations in the Toolbar

Toolbar icon Description

Start a new sequence file.

Open an existing sequence file.

Save the current sequence file.

Save all open sequence files.

Cut the highlighted command and place it on the
Clipboard.

Copy the highlighted command onto the Clipboard.

Paste the contents of the Clipboard below the current
command in the command tree.

View the Clipboard contents.

Delete the currently highlighted command.

X |88 &0 mE D

Add a new command below the current command in the
I'ﬁ'dd Camment Ll | command tree.

Print preview. View/print report of the current sequence
file.

o

Validate the current sequence file. Check command
values and relationship errors. Highlight an error and then
display the command to make corrections.

[]

Run (execute) the current sequence file.

AlC

View configuration and default options.

View Help screens.

&
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Toolbox

Click icons in the Toolbox to insert commands in your
sequence files. The Toolbox offers easy access to commands;
those commands also appear in the Add Commands drop-

down list in the Toolbar.

Table 4-3: Commands in the Toolbox

= =

Call MNotepad

Group Execute
i
Procedure  External

Aspirate Dispense

Ll
B Call Procedure

B (See page 4-10

for definition of

command types.)
Notepad

Group
Commands

Execute External
Application

Procedure

External
Procedure File

= Global Value

fm 1) | [ || OB,

Description
lcon Command Command Type (NOTE: Detailed descriptions begin on page 4-45.)
Intrinsic Calls a procedure from within current sequence file

or from another sequence file. Saves time by
reusing an existing procedure.

Creates a note in the sequence file. Does not
execute an operation. Useful for documenting steps
and for providing other commentary for user.

Groups commands together for a common purpose.

Executes an external application.

Executes a series of commands when the
procedure is called from the main sequence.

Imports all procedures contained within an external
sequence file into the current file.

Allows you to designate a command as “variable”
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Description
Icon Command Command Type (NOTE: Detailed descriptions begin on page 4-45.)
#ﬂ Assign Global i;’;\]szlgpostgcgllobal Value to an individual command
Assign | Value
é Export Global E;tpac;rt data to an external program (i.e. Barcode
Export Value
Module-Specific Aspirates a measured volume into syringes. Must
| ﬁ I Aspirate (See page 4-10 be preceded by Move to Position.
for definitions of
command types.) Dispenses a measured volume or all solution in
| ﬁ I Dispense syringes. Must be preceded by Move to Position.

Move to Position

ﬁ Home Axes
Pause

% Wash Tips
@ Mix

Message Display

Pump Control

Speed Control

Change DARTs
tip magazine

Positions stage or tray table in specific location on
the instrument.

Resets stage or tray table to home position.

Inserts a pause into a program (sequence file) to
stop processing according to pause parameters.

Washes inside and outside of tips. Must be
preceded by Move to Automation reservoir vessel

Aspirates and dispenses a measured volume in
specified cycles to mix microwell content. Must be
preceded by Move to Position.

Allows display of custom message on the device
display panel.

Allows direct control of wash pumps, independent
of a wash routine. Must be preceded by a Move to
Position command.

Allows adjustment of piston (syringe-plunger)
speeds for Aspirate, Dispense, Empty, and Wash
operations.

Reminds the user to change the DART tip
magazine during a sequence. Plate stage should
be in the down position to allow clearance for
moving the tips.

Click and drag the Toolbox to position it anywhere within the open Main Application
window. You can “dock” it by positioning it against any side of that window or allow
it to float on top of other window dialogs so that the icons are always visible.

You can set the size of the icons to small or large and view them with or without text
labels. Select these options from the View menu.
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Status Bar

Open files [1] E Clipboard active | Auto corect: On | Current file 'Corning 4 subwell protocal. cms'

The Status Bar provides information about what is currently running in the
ControlMate window environment.

Open files—Number of currently open sequence files.

Clipboard active—Indicates whether the Clipboard contains some cut or copied
material.

Auto correct—Indicates whether automatic correction of command errors is ON or
OFF. Toggle this setting on and off in the Tools> Options>Limits. With Auto correct
on, the software immediately checks a command for limit errors when you set the
command in a sequence file. If it is off, individual commands are not checked for
command errors until you validate the entire sequence file.

Current file—Name of the current open sequence file. If there is more than one
sequence file open, this panel lists the topmost file.

Command Groups in ControlMate Software
The ControlMate software commands are divided into two groups:

m Intrinsic
m  Module-specific (“Module” = device; your module is “Hydra DT.”)

Intrinsic commands are specific to ControlMate rather than to a module. The
commands are normally associated with the control of program flow and annotation.
The intrinsic commands are:

Main Sequence*

Procedure Library*

Call Procedure

Notepad

Group Commands

Execute External Application
Procedure

External Procedure File
Valve Control*

Global Values Module

6. Global Value
7. Assign Global Value
8. Export

(*Main Sequence, Procedure Library, and Valve Control do not appear in the
Toolbox or Add Commands list. Main Sequence is at the top of the command tree for
every sequence file. Procedure Library appears in every command tree. See page 4-56
for information about Valve Control.)
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Module-specific commands are specific to the Hydra DT device. They control
syringe-head movement, X/Y Stage movement, and liquid-handling parameters. The
module-specific commands are:

Aspirate

Dispense

Movements to position for pipetting
Home Axes

Pause

Wash Needles

Mix

Message Display

Pump Control

Speed Control

Change DARTSs Tip Magazine Command

Examples and discussion of the command screens appear later in this chapter, under
“Command Reference” starting on page 4-45.

K

Note: The commands are listed in the order that they appear in the Toolbox and
in the Add Commands drop-down list.

Child Dialogs in ControlMate Software

Actions within ControlMate are presented as child dialogs—that is, each of these
screens or tools appears within the Main Application screen. Each dialog has specific
tasks. Table 4-4 lists and describes the dialogs.

Table 4-4: Child Dialogs in ControlMate software

Dialog Access Description

Options

Set default parameters for a number of
options within the ControlMate

o
Tools>Options or on Toolbar application.

Sequence Editor

File>New Sequence; Open Sequence or

- |
D , @ on Toolbar

Create or edit a sequence file.

Click icons to insert commands in

Toolbox on Main Application screen sequence files. See “Toolbox” on page
4-8.

Print Preview File>Print Preview or & on Toolbar View text description of a sequence file.

File Validation RunsValidate File or on Toolbar Check a sequence file for errors.

File Execution

Run>Start or El on Toolbar Start a sequence-file run.

View commands that have just been cut

Clipboard Viewer Edit>View Clipboard or ﬁ on or copied from a sequence file command

tree.
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Dialog Access Description
Toolbar
Edit and Run on Sequence Editor screen Rggtrlct edit and/or run (exlecutlon)
Locks privileges for a sequence file.
File>Open Sequence>File Locked or
Password Enter password to access (unlock) a
Validation ﬁ on Toolbar locked sequence file.
About Help>About Vlevs_/ information about the software
version.

This concludes the overview of the software. The rest of the topics in this chapter
show you how to use the software.




4. Check the software configuration

Verify That System Connections Are Correct

. Click the ControlMate icon on the Desktop.
The Login screen appears.

H:MATRIX

Huiel thinking,

Y

S 0

=] £

wWersion 1.3.33

. fluid thinking,
"‘f\ﬁ*cowﬁ%tmrﬁ'

Module version 1.1.18 for Hydra ll |

Then the Main Application window appears.

+ Matrix Technologies Corp - ControlMate &
File Edit Wiew Run Tools Add-Ins Window Help

Toolbox

5 1B

Call Motepad
Group Execute

Procedure  External

0\

Aspirate  Dispense

o T8

Move Home

|D o | E S| % %W X[dsComand [k R B[P

= =l
L=
Pump Speed
T-1
Change
|Dpen files () | |Auto conect: On |
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2. From the Add-Ins menu, select Set Device and Pipettor Options.

File Edit “iew Run Tool

D BN %W

Wwindow  Help

The Add-In: Set Device and Pipettor Options window appears.

Addin: Set Device and Pipettor, Options

Device
Swyringe count

# stage positioner

Pump module
elrop module

Selected

Pipettor
DARTS magazine

Tip count

Auto wazh module

wr wash vessel

#1 wazh depth

Yolumes
Aszpirate/Dispense

Wash
Azpirate overstoke

Max air gap volume

Yolume Cormrection
Incremental dispense

Meat dispense

= Chanoed

’m DARTs capability [ M

r
r

|H_I,J|:|ra DT 36 with 3 stage » positioner

|DAATS 96 1.0ul - 30ul long tips (5506+5507) ~|

96 Tip outzide diameter |55 1100 mm

Tipbottom height ™ (5325 | 1/100mm & | §

|The auto wazh module can be uzed with these tips

|.f-‘« wazh veszel placed on the XY stage can be uzed with theze tips

100 j 1100 rm

1 to I?,Ij— Increment Ir ul
10 to (30 Increment (10 ul
3 j spithack |1 j ul
=

|No volume carrection : incremental dispenze -

|Nn valume comection : neat dizpense -

Reset To Facton Default Settings ‘

0k ‘ Cancel | Help ‘
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3. Select the DART's capability option. This option configures the software to enable
parameters relating to the removable DARTS tips. If you uncheck this option, the
ControlMate software returns to the fixed-head hardware configuration. This
option can also be set automatically by clicking the Query Device button.

Device

Syringe count 95 w | DARTs capabilty [v Query Device
X stage positioner Maone -

Fump module Mone
2 positions
elrop module e . |

Selected Hydia DT 56 with pump module

4. Select the X/Y stage positioner if it is part of your system; otherwise,
select None.

5. Select the Pump module and/or eDrop module options if they are part of
your system. The Selected field is a read-only text fild that confirms the options

you have selected.
6. Select the DARTSs magazine that matches the pipettor head on your Hydra unit.

Pipettor
DARTS magazine | DARTs 98 1.0ul - 30ul long tips [S506+5507) -
Tip count DARTs 96 5ul - 200ul long tips (553645537

Tio bottom height DART= 96 Bul - 300ul standard bips [B516+5517)
in bottom height 5% | e 36 Bl 3000l wide bore fips (55455547 /5548

Auto wazh module |The auto wash module can be used with these tips
W1 wash vessel |.-‘-‘« waszh vessel placed on the XY stage can be used with these tips
1 wash depth 100 j 14100 mm

The read-only text fields for the Tip count, Tip outside diameter, Auto wash
module and XY wash vessel confirm your selection.

7. Determine the tip bottom height of the disposable tips.

a. Insert a DARTSs magazine in the pipettor head and a microplate (similar to the
one you will be using) on the single or XY stage.

forming a seal at the bottom of the well.
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Pipettor

DARTS magazine |DAF|T$ 96 1.0ul - 30ul long tips [(5506+5507) j
Tip count ’SE_ Tip outzide diameter |55_ 1100 mnm

Tip botior height % 5300 ~< 17100 mm E i

Auto wash module |The auto wash module can be used with these tips

A wash vessel |.f-‘« wazh vessel placed on the ¥ stage can be used with these tips

Y wash depth Mo0 = 1/100 mm

8. If you want to reset Aspirate overstroke, spitback volume, or the maximum air
gap volume, you can make those changes now. See the description of the fields on
the AddIn Set Device and Pipettor Options screen on page 4-23 for details about
these options.

fispirate overstioke |3 ﬁ spitback |1 j ul
tlan air gap wolume |55 ﬁ

9. Click OK.

10. From the Tools menu, select Options.

Add-nz

File Edit “iew Bun K

D W

The Options dialog appears with the Connection tab on the top layer.




Addln: Set Device and Pipettor, Options

Device

Syringe count 95 «| DART: capability [ Query Device

=1 ztage positioner 3 positions -

Purnp module r

eDrop maodule r

Selected [Hydra DT 96 with 3 stage ¥ positioner

Pipettor

DARTS magazine | DARTs 95 1.0ul - 30ul long tips (S506+5507) |

Tip count 95 Tip outzide diameter |55 14100 mm

Tipbottom height T (6325 | 1/100mm & §

Auta wazh module |T he auto wash module can be used with these tips

=1 wash veszel lfi‘n. wazh vessel placed on the = stage can be used with these tips

5 wash depth 100 =+ 1/100mm

Yolumes

Azpirate/Dizpenze 1 to |30 Increment (0.1 ul

Wazh 10 to |30 Increment 10 ul

Aszpirate overstroke 3 j spitback. 4 j ul

b aw air gap volume 15 j

Yolume Cormrection

Incremental dispense |ND volurne comection : incremental dispense j

Meat dispenze |N0 volume cormection : neat dispense ﬂ

Reset To Factory Default Settings |
ak. | Cancel ‘ Help |

=0 Chanaed

a) Verify that Connection settings are correct for your system. Standard settings
are shown in the preceding screen. Make corrections to the settings if
necessary.

b) Click Test to test the serial connection between the device (Hydra DT) and
the computer. When you click test, the computer communicates with the
device by issuing a reset command. A warning message will be displayed if
the parameters have not been correctly defined or if the device is not
connected and switched on.

Note: If you press the Run icon [ after opening a sequence file (a program)
but the system does not execute the commands, the serial-port setting might be

Getting Started: Automated Operation 417



luiel thinking.

incorrect. If that problem occurs, open the Connection tab and click the Test
button to verify that the correct serial port is in use. If an error message appears,
select other ports until clicking Test no longer evokes an error message. Then try
again to run the file.

View Commands and Limits Tabs
The Commands and Limits tabs contain default parameter values.

Click the Commands tab and then select a command from the drop-down Command
list to see the default settings for a command:

Connection  Commands | Limilsl F‘usi!ionsl F‘Ialesl Mutorsl

Command -

Default Val Sspirate

Home Axes
Message Display
Mix

Move to Position
Pause

Pump Control

Connection  Commands I Limitsl F‘Usitiunsﬂ F'Iatesl Muluvsl

Command

Default Values

Yolume Al
U ¢ Specific 0100 j ul
Dl time: |D ﬁ 1/100 seconds
Tiptouch [~ Action I Side left _j

When you insert a command in a sequence file (“sequence file” is the ControlMate
name for a program), parameter values for that command are automatically set to its
Commands tab default values. Setting default values for commands can save you
time in creating sequence files. For example, if you frequently use a particular piece
of labware in a particular stage position, you could set defaults for that labware and
that stage position in the Move to Position command. When you insert the command
in your sequence file, you will not have to edit the command screen.

You do not have to use the default values that have been set for a command on the
Commands tab—you can edit the values for the command as you create your
sequence file in the Sequence File Editor.
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Now click the Limits tab to see the Limits screen.

& Oplions M= E3

Conneclioni Commands  Limits I F‘Dsitionsi P\atasi Motorsl

Vale Min _ [Max |  Unit
Aspirate or Dizpenze valume iy 110 ul
‘Wash volume 10 110 ul

Air gap volume: 01 1) ul

[Drelay after aspirating o 1000 1,/100th zecond

[relay after dispensing 1] 1000 1/100th second
Pavze durstion 1 100 Seconds
tix cycles | 10 |terations
Wash cycles 1 Iterations
Z auiz height a 14100 mm
# anis linnits 0 1100 mim
' 2w linnits 0 14100 rm

Auto comect invalid values during command edit W

The Limits tab establishes minimum and maximum values for some parameter
values. If you need to set new limits for your applications, you can edit values that
appear in black type on this screen.

Note: We recommend that you set the “Auto correct...” option, at the bottom of
the screen, to ON. When this option is turned on, the system automatically
checks values you set in a command screen and reports an error if you set a

value that is outside the range established as default Limits settings.

IMPORTANT: Limits settings override Command settings. See the following
description of a “Limits override.”

For example, if the Limits tab setting for “Delay after dispensing” is 1000:

Eonne:lionl Commands | Pn&itinnsl Plakesl Mnlnlsl

Value Min | Max | Unit
Aspirate or Dispense volume 01 110 ul

Wash volume 10 110 ul

Ajr gap valume: 01 55 ul

Delay after aspirating 0 000 24100th second
Delay after dispensing 0 1000 1j100th second
Pause duration 1 100 % Seconds
Mix cycles 1 10 Iterations
Wagh cycles 1 16 Iterations

Z ariz height 0 13000 14100 mm

# ais limits 0 16090 1/100 mm

Y ais limits 0

Auto corect invalid values during command edit [V

Getting Started: Automated Operation 419



luiel thinking.

and you set Dwell time to 2000 on the Commands tab for Dispense:

Connection  Commands l Limitsl Positions]l F‘Iales] Mntorsl

Command  [pispense vI
~ Default Yalues

ﬁ Wolurne @& Al
I I £ Speciic pio =] ul

Diwell time I2E|Ua <~ 1/100 seconds
Tip touch m— I e ;]

then when you insert a Dispense command in a sequence file, you will see the
following error message and reset value for Dwell time:

]E[ Dispense

Wolume e Al
Specific o100 = ul

= |
i )
Dwelltime 11000 § =2 14100 seconds
Tiptoush [ Achion I Side left _:J

Dwell time: [1/100 seconds] too high (0 - 1000] auto corrected ta maximum

View the Motors Tab Settings

g5 Options

Caonnectian I Commands I Limits I Positions ! Plates

X Axis
mmperstep o072 = ‘
¥ Axis

mmpeistep 00072 = ‘

Z Axis

mmpersiep 00z = ‘

The speeds at which the stage will move in the X and Y axes and at which the stage
or tray table will move in the Z axis have been set for you.

Caution: We recommend that you do NOT reset these speeds without first
consulting your equipment provider. See page 1-9 for contact information.
Resetting motor speeds could cause the instrument’s stage or tray table to move
more quickly than you had intended and perhaps damage the stage or syringes.
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5. Calibrate the stage (Hydra DT with X/Y Plate Stage systems
only)

Before you begin using your Hydra DT with X/Y Plate Stage system, you need to
calibrate the stage.

The values that are set during stage calibration are also used when determining plate
definitions. Any change in calibration coordinates will cause a change in all plate
definitions.

Note: After calibrating the stage at installation, you will need to recalibrate the
stage ONLY if it is accidentally bumped and shifted out of its calibrated position
or if you move the system.

é Caution: Always attach the shipping plates on the stage (see page 2-2) before

moving the Hydra DT system. Failure to do this may result in damage to the
stage.

Before You Start
When you are ready to start the stage calibration, have these items available:

m A standard 384-well microtiter plate to calibrate the stage for a 96 syringe
configuration (use 1536-well plate for 384 syringe configuration)

m Flashlight (optional)

movement is restrained, the position information will be lost and the stepper
motors may attempt to drive the stage beyond its allowable limit. If this happens,
click the Emergency Shutoff Switch.

é Caution: Do not interfere with the stage when the system is running. If the stage
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Procedure 4-1: Calibrate the stage

1. Start the software if it is not already started, and select Add-Ins>Set Device and

Pipettor Options. Verify that the settings on the screen are accurate for your

system.

AddIn: 5et Device and Pipettor, Options

Device

Syringe count 96 » | DARTs capability [ Query Device

*1" stage positioner 3 positions -

Purmp module -

elirop maodule -

Selected Hydra DT 96 with 3 stage v positioner

Pipettor

DARTS magazine | DARTs 98 1.0ul - 30ul lang tips (5506+5507) |
Tip count ’EIE;— Tip outside diameter 55 14100 mm

Tip battom height T 5325 | 1/100mm & | 5|

Auto wazh module |The auto wash module can be used with these tips

7 wash vessel |.-’-'« wash vessel placed on the = stage can be used with these tips
s wash depth Wj 1100 mm

Volumes

Azpirate/Dizpense ’1_ to I:-‘,El_ Increment Ir ul

Wazh "ID_ to ISD_ [ncrement |‘ID_ ul

Aszpirate overstroke 3 j spitback. |1 j‘ ul
Max air gap volume 15 j

Yolume Correction

Incremental dispense |N0 wolume comection : incremental dispense

[~

Meat dispense |NU volume corechion | neat dispense ﬂ
Fieszet To Factary Default Settings |
] | Cancel ‘ Help |
= Chanaoed

i T Note: The information set up here will be used in any sequence file

command, so it is important that the information is accurate. The
information loaded must correctly reflect the physical characteristics of
the pipettor head and tips currently loaded.

You can test the height settings by selecting the up arrow button. Reset the stage
by selecting the down arrow button.
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Fields

® Device—Specifies the Hydra DT base model device type and attached
hardware modules (ie. the X/Y plate stage).

® Pipettor—Specifies the tips set currently installed. This is important since all
actions have to take account of tip length and outside diameter.

e Tip count—Number of tips in the tip set.

o Tip outside diameter—The tips’ outside diameter. This value is used in
positioning movements such as tip touch and well offsets.

e Tip bottom height—Used to determine the reference point from which all
height movements are calculated when positioning stages at the pipettor head.
The value is measured from top surface of a stage at the home position (at the
lowest point) to the end of the tips (when the magazine is loaded). Getting this
value wrong will cause all height movements to be inaccurate.

®  Volume ranges—Identifies minimum and maximum values used for checking
the piston movement for volume limits.

o Increment—Used for determining the increment value associated with the
volume increment and decrement buttons in a number of sequence commands.

e Aspirate Overstroke—Identifies the amount of overstroke that is applied if
Overstroke is selected in the Aspirate command. A good starting point for the
overstroke amount is 5% of syringe volume; adjust the volume for your
system as necessary. If you choose not to use Overstroke at all, you can set the
Overstroke volume (and the spitback volume) to O (zero).

e Aspirate spitback—Identifies the amount of liquid to be returned immediately
after the overstroke volume is aspirated and before the specific volume is
aspirated within an Aspirate command.

®  Maximum air gap volume—Specifies the maximum air gap to be applied if
Pre air gap is selected in the Aspirate command. See page 6-9 for
recommended air-gap volumes.
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Command Buttons
4 | (Test height)—Communicates with the device to test the associated height.
_E_ (Reset from test height)—Resets the device axes and is used to reset the
———1 device after testing heights. All axes will return to their home positions.
Reset To (Reset to Factory Default Settings)—Resets all field values for the
Factory Defaul . . . . . .
Sewngs | current piston/tip configuration to those originally set as the factory

default values. Any changes that have been made, via this dialogue,
will be overwritten.

2. Select Tools>Options.

3. Click the Positions tab and verify that the settings for the Pipettor:Stage 1
position are as shown in the following screen. These settings are standard for the
stage when the source (left) nest is under the dispensing head. If those items do
not appear in those fields, select them or type them in. Then leave the screen
open.

Note: When you are aligning the needle tips on the intersection of a 384 or 1536
well plate, you might find it helpful to shine the light from a flashlight at a right
angle to the needles to enhance visibility.

& Options |_ (O] x]

Eonnectionl Commandsl Limits F'Iatesl Motorsl

Paosition |Pipettor: Stage 1 :'I
~ Adjust physical locati —Manual

V. } Changing any * or ¥ home values or
‘-" ! uzing the Manual Movement buttons Steps (mm)

will zauze the pipettor head to mave. & @l

Xhome [15400 < 1/100mm
= || = 1
Yheme [10100 = 1/100mm

Maove |ﬁ| -] -0

’fTest height ‘

[0 = 1/100mm
 Detail for :

Koffset [450 =t =111

450 Ty e 450 |y e Reset To Factory
Y offset [o ﬂ to [450 j 1100 mm Default Settings
Z offset ID j to |60000 j 1100 mm

0K | Cancel | Help |
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Note: If an eDrop device is attached, the window will display an additional field
(EMB Device) to position the stage for the eDrop needle. See Appendix E for
eDrop information.

Each defined position on the Hydra DT system has been mapped to a specific
location: for example, the Pipettor:Stage 1 position places the source (left) nest on
the stage directly under the syringe head. Positions for the Hydra DT with X/Y
Plate Stage systems can be set along 3 axes. These axes are shown in the
following diagram.

’Zl‘ ;

You can use the Positions dialog to set the minimum and maximum values that
the stage can travel on any one of the three axes at any of the defined stage
positions. These values are then used within the Sequence File Editor for each
respective command.

Fields

e Position—The defined stage position. If you select a different position from
the dropdown list, the stage resets to home position before moving to the new
X,Y location.

o Adjust physical location: X and Y home—Use these fields to directly enter the
respective axis value, in 1/100 mm increments, to set the required position.

®  Manual movement—The manual movement buttons are used to directly
control the deck motors to move to the required position. The deck will move
in the direction specified by one motor step increment, the value for which is
set by the “Steps (mm)” slider. For example, if the slider is set to 1 mm steps
and the “move to the back” button is pressed, then the deck will move 1mm
backwards.

o Test height—Height at which the tips will be positioned after the deck
movement. This is useful for gauging the tip location. If a new position is
selected in the Position field, then the tips will ignore this height and move to
the safe travel height first.
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e EMB Device—This field allows you to select the associated eDrop (Electro
Magnetic Bellows) device. This field will only be available if an eDrop
related position is selected in the Position field.

® X offset—Specifies the amount of movement the stage can move from left to
right (and right to left) in this position. Two fields represent the setting, with
the first being the minimum value and the second being the maximum value.
A negative value causes the stage to move to the right (therefore moving the
tips to the left of a well, for example).

® Y offset—Similar to the X offset fields except that the values represent
movement of the stage in the selected position from back to front (and front to
back).

® 7 offset—Similar to the previous two fields; represents the up and down
movement of the stage in the selected position.

Command Buttons

M ove (Perform movement)—Clicking on this button will communicate with
the device to test the associated position.

‘ﬂﬁ| (Reset from test)—Resets the device axes and is used to reset the device
after testing heights. All axes will return to their home positions.

01 (Move in motor steps) —The deck will move in the direction specified by
one motor step increment, the value for which is set by the “Steps (mm)”

slider. For example, if the slider is set to 1mm steps and the “move to the
back” button is pressed, then the deck will move 1mm backwards.

| (Move the deck to the back)
(Move the deck to the front)
(Move the deck to the left)

(Move the deck to the right)

Reset To Factoy | (RES€1 10 Factory Default Settings)—Resets all field values for the
Default Settings | cyrrent position configuration to those originally set as the factory

default values. Any changes that have been made, via this
dialogue, will be overwritten.
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Troubleshooting Calibration of the Hydra DT with X/Y Plate Stage

System

Caution: If you receive error messages when calibrating the stage, the
computer may not be communicating with the Hydra DT microdispenser. Follow

the steps below to troubleshoot the problem.

1. Make sure the cables connecting the serial ports of the computer to the Hydra
DT microdispenser are securely attached. Only use the cables shipped with the
system. If the cables are loose or not connected, repeat running the calibration
procedures. If the stage fails to move again, go to Step 2.

2. From the Tools menu, select Options.

The Options dialog appears, with the Connection tab on the top layer.

Add-Ins  Window Help

) | < [t ]

= | P

Conneation | Commands | Limit: |

] F'Iates] Motors]

A

Getting Started: Automated Operation

Hydra Il

Serial port 5 j Test
Firmnware
Send delay 1 j 14100 zeconds

Palling retry count 1 j

Transaction log

Selected v Clesar

3. Click the down arrow next to the Serial port field to get a list of ports, and

select another com port. Click OK.

4. Repeat the calibration procedure.

Caution: If the stage still does not move, repeat Step 2 through Step 3 in this
section, selecting different Hydra DT com ports. If the stage will not move after
you have tested possible com ports for your system, call your PC service

technician.
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6. Create labware

You must provide a plate definition for each type of labware you will use with your
Hydra DT system. Plate definitions are stored in a database and are used when
constructing sequence files (in the ControlMate software, “programs” are called
“sequence files”).

A set of plate definitions is included in the ControlMate software for you to use as a
starting point for your plate definitions. If you are using industry-standard labware in
your applications, you will be able to use some of those provided definitions without
having to make many, if any, change to them.

Place plates on the tray table or in the source (left) nest on the stage to define them.
On the Hydra DT with X/Y Plate Stage system, precise manufacturing of the two-
position plate holder allows information obtained during plate definition in the source
nest to be translated into the correct coordinates for the destination (right) nest.

z Note: These limitations on types of labware that can be used with the various

Hydra DT system setups:
m A 1536-well plate can only be used on a system that includes the X/Y Plate Stage.

m  On Hydra DT 96 systems that do not include the X/Y Plate Stage, you can use
384-well plates using the 96/384 manual plate positioner.
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Setting Labware Values: Overview

Use the Plates tab under Tools>Options to create, edit, and delete labware
definitions.

Description of Parameters on the Plates Screen

&5 Options

Cannection ] Cammands ] Lirnits l Pasitions ~ Flates l Matars l

Plate Type
Description | 384 Round well flat [35000111/11121/11112) -]

Add ‘ Delete |
Detail for :384 Round well Fat [36000111/11121/11112)
Vessel : Type |Plate ﬂ Height [1020 ::||1 2100 mm
Well : Count |384 ﬂ Shape |Hc-und ﬂ Diameter  [300 ::||1.n’1 00 mm

Spacing (450 :II 14100 rarm
Depths (14100 mm]:  Well ]300 = Aspirate Lo 4[500 =
Tip tauch L' 200 j Dizpenze 1350 ﬁ

Getting Started: Automated Operation

Well quadrant centers [1/100 mm] : Quadrant | X axis |Y . T2 | —x
* ‘when 96 tips are uzed -V | ¥
" when 384 tips are used ! L3 2 T |-
2 225 225 +v | +v
3 225 225 Quadrant =77
4 2R 295 coordinates
Sub well : Count n - -
Ll = LeJ =
|
0K | Cancel ‘ Help ‘
Fields

Description—The required vessel type for which parameters are to be changed.

Vessel type—The collective name for the vessel; for example, “plate” or
“reservoir.”
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Height—The physical height of the vessel, measured from the bottom of the plate
to the top of the plate. The height is important as it is used for all movement
commands when calculating the height at which the stage can be safely presented
to the tips and also for tip touch positioning, and so on.

Well count—The physical number of wells contained within the vessel. The field
is used for determining positional parameters for quadrants, and so on.

Shape—Represents the physical top shape of the well and can either be Square or
Round.

Width/Diameter—Represents the physical width/diameter of the well measured at
the top of the well. The well width is especially important for determining well
centers, quadrant offsets and tip touching.

Well spacing—Used when determining the distance (in 1/100mm) between well
centers. The field value is measured from the center of one well to the next and is
also known as the “well-to-well” spacing.

Well depths—Defines a pre-set height that defines the bottom of the well.
Measure from the well top to the well bottom at the well center.

Aspirate depth—Represents a pre-set height, available within the Move
command. This height is useful for setting a default height at which liquid is
aspirated. The larger the value, the higher the stage movement (and therefore the
further down into the well the tips are positioned).

Dispense depth—Similar to the Aspirate Depth, with the exception that it is used
for determining a pre-set height for dispensing liquids.

Tip touch Z offset depth—Sets a value that will be used when positioning the
vessel for tip touch off. The value is used to determine how near to the top of the
well the tips are positioned; for example, a value of 200 1/100mm will position
the vessel so that the tips are approxi-mately 2mm inside the top of the well.

Well quadrant centers—The quadrant grid can be used to enter values that
represent the well centers for each quadrant. The X and Y axis offset values are
measured from the tip center position when no offsets are applied; for example,
the dead center for a 96-well plate.
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Applying Offset Values in the Plate Definition

To determine the offset values applied, the direction that the stage has to travel is the
opposite of the location of the quadrant; that is, to position tips to the left and back of
the plate the stage has to move to the right and towards the front of the
microdispenser.
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The Quadrant X/Y coordinates frame in the Plate dialog window shows how to apply
the offset values.

B(=1Ed

Connection ] Cormmarids ] Lirnits ] Pagitions ~ Plates l Matars ]
Plate Type
Description | 334 Round well flat (36000111/11121/11112) ~|
add | Delete |
Detail for :384 Round well flat [(36000111/11121./11112)
Vessel - Type |F'Iate j Height [1o0z0 :jllh"IUEI i
Well = Count |384 ﬂ Shape |H0und j Diameter  |200 jh"IDD mm
Spacing [450 j 1100 rann
Depths (1100 me) . well |y [500 j Aspirate |+ | [E00 j
Tip touch L' 200 j Dizpenze L350 j
Well quadrant centers [1/100 mm) : Quadrant | X axis |Y . Tz [—=x
f* ‘When 96 tips are uzed - | =¥
" when 384 tips are used L et ed T= [—=
2 2R 2R +v | +v
3 225 225 Quadrant #.)
4 225 225
T e - -
— —
lig s |
JEN| =1
L = L4J =
D —
Ok, ‘ Cancel | Help ‘

4-32

Setting the Number of Quadrants in a Plate Definition

A different grid with different quadrants is available for each plate. The total number
of quadrant groups (that is, 1, 4, or 16) depends on the total number of wells
contained in the vessel and the current selection of the tip radio buttons. The radio
buttons are used to re-draw the grid based on whether the system is a 96 or 384
model.

For example, setting the radio button to 96 tips for a 384-well plate would display a
grid containing 4 quadrants.
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Determining Parameters to Be Set for Various Labware Types
Table 4-5 lists required parameters for the different types of labware.

Table 4-5: Labware Types and Required Parameters

Parameters to set for this labware type Labware Type
Plate Reservoir
Name X X
Vessel type X X
Height X X
Shape X X
Well depths X X
Well count X X
Well spacing X
Width/Diameter X
Well quadrant centers X*
*Well quadrant centers are required only for plates that (1) have a Well count greater than
the number of syringes and (2) are used on Hydra DT systems with the X/Y Plate Stage.
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Procedure 4-2: Create, edit, and delete labware

Before You Start

m  Have a caliper measuring tool available.

Create a New Plate
1. Go to Tools>Options>Plates.

2. In the Plate Type area, click Add.

&' Options

Connection ] Commands I Lirnits ] Pasitions ~ Plates l Mators I
Plate Type

Description | 384 Rovund well flat [38000111/11121/11112]

Detail for :384 Round well flat [36000111/11121/11112)
Vessel : Type |F'Iate ﬂ

j Shape |F|Dund j
Spacing |450 j‘ 1100 mm

Wwell : Count | 284

=

Add | Delete ‘

Height [10z0 jmuu mm
Diameter  |300 j'lf'lﬂﬂ mm

Depths [1/100 mm] :  wiell gy [500 = Aspiiate |2g[500 =
Tip tauch Ll 200 j Dispenze | 4350 j

Well quadrant centers [1/100 mm] : Quadrant | X axis |Y f— T2 |—x
+ ‘when 96 tips are used -V | ¥
" when 384 tips are used ! L 2 T |-
2 -225 -225 +7 | +v
3 225 225 Quadrant %7
4 295 295 coordinates
Sub well : Count o - -
= =
LeJ = L =
|
QK ‘ Cancel ‘ Help ‘
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The New Plate Type screen appears, with an empty Description field.

Connection ] Commands ] Lirnits I Plates l Motors ]

Mew Plate Type

Dezcription |

Sirmilar to... | Mone

Detail for : New plate

j Apply Cancel

Vessel - Type |F'Iate ﬂ Height |0 j‘l.-"‘l 00 mm
Well = Count |95 ﬂ Shape|F|0und ﬂ Diameter |0 j‘l.-"‘IDD mm
Spacing |0 j 14100 mm
Depths (1700 mm):  Wel |4[0 =] hspiate |3[0 =
Tip tauch Ll il j Dispense |+ [0 j
Well quadrant centers (1/100 mm]) : | Quadrant |X p— |Y . t= |-=
& ‘when 96 tips are used v | —¥
o +2 |-x
+y | +¥
Quadrant 34
coordinates
Sub well : Count 0o -
|
=]
|
=]
L& =
|
=]

3. Type a name for the new plate in the Description field.

—Mew Plate Type

Deseription [1536 round well |

Similar to... INone

[

If the plate is similar to one you have already created, select that similar plate

from the Similar to... list.

Getting Started: Automated Operation
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The New Plate Type screen shows values for
selected.

the Similar to ... plate that you

Connection ] Commands ] Lirnits ] Plates l Matars ]

Mew Plate Type

CEX

Descripion 1536 round wel

I Similar to... {153 Square wel Matis (4511B-45178)

j I Apply Cancel

Vessel - Type | Plate ﬂ Height 1200 j1 A100 mm
well : Count |1535 j Shape |Squa[g j width  [170 j]ﬂ 00 mm
Spacing (225 j 1100 ram
Depths (1100 mm):  well |4 [450 j Aspiate | 4§ [250 j
Tip touch (¢ [200 j Dispense |+ [250 j

Well quadrant centers [1/100 mm) : Quadrant | X axis |Y p— o [+= [—=
* when 95 tips are uzed =¥ | =¥
" ‘when 384 tips are uzed 1 =8 38 t= |-m
2 13 338 +7 | +y¥
3 13 -338 Quadrant %77
4 e 33 | coordinates
Sub well : Count 0 - -
— =
L = L2 =
& =
QK | Cancel | Help |
IE Changed

Use your calipers to determine values for all required parameters for this type of

labware.

Enter and/or change plate values in the Detail for: New plate area of the screen,

as follows:

If the plate is not similar to any defined plates, enter values in all the required

parameter fields.

If you selected a “similar to” plate, make any
values that already appear on the screen. In th

necessary changes to the parameter
e following example, we changed

the value for “Shape” (of the top of the well) to Round. (Note that the parameter
name “Width” changed to “Diameter” when we made that change in shape

selection.)
Caunt | 1536

: j Shapilﬂound j
Spacing [205 j 1410

well

Diameter {170 ﬁ'l.-"lﬂﬂ mm

When you are finished entering and changing values for the plate, click Apply

and then click OK.
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Caution: This function changes an existing plate definition. Before you edit a
plate’s definition, determine whether the CURRENT plate definition might
continue to be needed in existing sequence files. If this plate type is still needed,
exit this function and follow the steps to add a new plate type. Select the existing

plate type in the field “Similar to...” and then make your changes.

1. Go to Tools>Options>Plates. The Plate Type screen appears.

~Plate Type

Deseription {1536 Square well Marix' (45116-4517E)

[ | Delete |

—Detail for :1536 Square well "Matnx’ [45118-4517B)

Vesseltype [Plate  v] Heiht  [1200 = 1/100mm
‘wiell count I1538 ;i Shape lSquare_'_! width |1?EI j 14100 mm
well spacing  [225 j 14100 mm

—Depths (17100 mm)
wel  Led[s50 = Asriate sy [350 =] TitouchZofiset ¢ [zpn =]
Dispense |4 [250 ﬁ
—Well quadrant centres [1/100 mm]) Note:
porcsbdeiote [ Qusdant [Xawe  [Veme 2] Gl
1 el e} positions
{+ 96 tps e P
 384tips 2 113 -338 —v | -v
3 113 -335 =
4 -338 -338 Ty =%

2. In the Plate Type area, click the arrow for the Description dropdown list and

select the name of the plate you want to edit.

—Plate Type

Desciption 1536 5 quare wel 'Malris' [4511B-45178)

Add | Delete |

384 Square well flat [4310-4324)

864 Affyman

9E deep well 1.0 ml [4211.24212)

96 deep well 2.0 ml [4221/4222)

96 latch rack 1.4ml tubes [4157./4158]
g

- Detail far -

Weszel bype
well court

well spachg

-
-

[

i‘__'A
== 14100 mm

Make any changes you need to make to the parameter values.

4. When you are finished making changes: If you want to save these changes, click
OK at the bottom of the Plate Type window. If you do not want to save them,

click Cancel.

Getting Started: Automated Operation
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Delete a Plate
1. Go to Tools>Options>Plates. The Plate Type screen appears.

~Plate Type

Description 1536 5quare well Matrix' (4511B-45178) ] A | Delete |

—Detail for :1536 Square well 'Matnix’ [4511B-4517B)

Vesseltype [Plate  v]  Height  [1200 | = 1/100mm

‘gl count |1538 'i Shape ISquare 'I width IWU j 14100 mm

Well spacing |225 j 14100 i

—Depths [1/100 mm)

wel  Le[50 = Aspirate |8y [350 = TiptouchZoffset b y[o00 =
Disperse %] !250 ::"1

—Well quadrant centres [1/100 mm]

Applicabale o t [ Note:
mg';‘lacz?n: t?na? hlgs___ Quadrant ¥ axis |Y axis - Quadrant %/
- 1 338 338 positions
{* 36 lips ===
384 tips 2 13 -338 e[l
3 113 338 T
4 -338 338 - +7 | +7

2. Select the plate type you want to delete from the dropdown list for the Description
field and then click the Delete button. The Delete Plate message appears.

= 1|
Description |384Houndwellflal[35000111.‘11121#11112] :Il Add |I Delete ||‘

Delete plate type

.,‘"a! Delete : 384 Round well flat (36000111/1112141112) 2

L

Caution: Any sequence files that contain this plate definition will not be
executable if the plate is deleted.

3. Click Yes if you want to delete the plate. Click No if you do not want to delete it.
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7. Create and edit sequence files

After you have calibrated the stage (if it is included in the system) and the labware,
you can create sequence files. Sequence files are the programs that you will run to
execute your procedures.

Follow these rules when you create sequence files:

m A Move command must precede (not necessarily directly) each Aspirate,
Dispense, Mix, and Pump Control command.

m If dispensing specific volumes, the total volume dispensed cannot exceed the total
volume aspirated.

m Typically aspiration must precede a dispense action (although the Aspirate
command does not have to appear in the position in the sequence immediately
preceding the Dispense command).

The following two procedures, Procedure 4-3 and Procedure 4-4, provide the basic
steps for creating and editing sequence files.

Detailed information about using the Sequence File Editor to insert commands into a
sequence file and then how to add, cut, copy and paste commands, as well as detailed
descriptions of the commands, appears under “Command Reference,” starting on
page 4-45. You can study that information now or you can begin the procedures and
refer to the reference information when you need to.

Note: A sample sequence file appears in Appendix C. It shows examples of
entering commands and of grouping commands.

Procedure 4-3: Create a sequence file

on, in the format "Vxxx" where xxx = Numerals of version number, no decimal
point separator; e.g., V515 = Version 5.15.

Start the ControlMate software if it is not already started.

. Click the New Sequence File icon — in the Toolbar.

. Type a name for the sequence in the Title field at the top of the Sequence File

z Note: *Firmware Version is shown on the display when you first turn the system
1
2
3
Editor screen.

4

. Enter commands in the sequence by clicking command icons in the Toolbox and
then selecting or entering values and options for those commands. Use copy and
paste functions, as well as the Group Commands command and the Procedure
command, to speed up file creation.

5. Click the Validate File icon = when you are finished adding commands.

6. Correct any errors that appear in the Validate Sequence File screen.
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7. Save the file:

8. Select Save As from the File menu:

ISCW Edit Wew Hun Tool Addlne Window Help

Mew Sequence File
Dpen Sequence File

Save

Save Al 0 pe! Files

9.

10. Type the name of the file in the File name field on the Save Sequence File

window and click the Save button.

Save Sequence File | 7]

Save in: Ia ContralMate j QI

E| AspirateTransfer.cms EI DryDispTul.cms EI Mix1.cme
@ AutoWash.cms @ Exerd-1Prog.cms @ tultipleDisy
@ Autow ashaW. cms @ group.cms @ MultipleDisg
EI demoProgram.cms EI I anualfash.cms EI MeatDisper
@ Disp2Times.cms @ Manual ashfordy ordiw. cms @ MeatDisper
@ DispwWetPlate.cms @ Manualw/asky. cms @ Rearray(4):
X | 2l
File name: |NealD ispense

Save as type: IEontmIMate sequence files

Procedure 4-4: Edit a sequence file

lj Cancel |

1. Click the Open Sequence File icon = i1 the Toolbar.

2. Select the file you want to open from the Open Sequence File window and click

Open.

1
Open Sequence File [ 2]

Laak i I {3 ControlMate

- & & =2

|_1 hasFroc {E?I Dizp2 Times. cms f?_ﬂ Mix1.cmz
le preda liﬂ Dispiw/etPlate.cms @ MultipleDispenze.cms
8] AspirateTransfer. cs {;ﬂ DiyDisplul.cms =] MultipleDispensel.cms
ﬁ Autotyfash.cms i:ﬂ Exerd-1Prog.cms @ MeatDizpense .cms

g‘l aw wazh.cms El i anuahafash.cms EI MeatDizpense. cms

] demnoProgram. crms 28] Maruahyashiy. cms Fﬂ washz.cms

4] | il
File name: |NeatDispense.cms Open

Files of type: lEontroIM ate sequence files

3. Click the plus sign = next to Main Sequence (and the plus sign next to
Procedure Library, if there is a plus sign there) in the command tree so that you

can see all the commands.
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4. Choose one of the following to begin making your changes:
5. Click on the first command/procedure that you want to edit.

6. Right-click a command/procedure if you want to add a command below it, delete
it, or copy and paste it, and then select the operation you want from the dropdown
menu.

i":“ Move to Pipettor: Stage 1

{i| Aspirate 10ul

%+ Move to Pipettor: Stage 2

|1| Dizpense Al
[EE] Procedure Librar

7. Edit the command as desired or select the values and options for the new
command or paste the copied material where you want to.

8. Make any other changes you wish to make to the file.

9. Click the Validate File icon = in the Toolbar when you have finished making
changes to the file.

10. If errors are listed in the Validate File Sequence screen, correct them.

11. Click the Save icon ™ in the Toolbar to save the changes to the file.
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8. Run a sequence file

Procedure 4-5, starting on this page, provides the basic steps for running a sequence
file.

Note: We recommend that you test run each new sequence file without using
solutions, so that you can be certain that the stage/tray table heights and other
parameters are correct.

Procedure 4-5: Run a sequence file

Before You Start
1. Review these Warnings and Cautions:

WARNING! To shut down the unit IMMEDIATELY in case of an emergency,
firmly press the red button on the Emergency Shutoff Switch.

%)
EMERGENCY
STOP

@ @

Figure 4-1: Emergency Shutoff Switch

Caution: Do not allow corrosive or oxidizing agents, such as chlorine bleach,
strong acid, etc., to be in continuous contact with the microdispenser. Such
agents can be used routinely with the Hydra DT microdispense but may damage
the case, and the tray table if left in contact with the instrument for extended
periods of time. If you need to use these reagents in a protocol, ensure that you
clean the microdispenser of any residual corrosive agent as soon as you finish
the procedure. If you need to use any strong oxidizing or corrosive agent other
than those listed in Table 6-9 on page 6-26, contact your equipment provider.
See page 1-9 for contact information.

on, in the format "Vxxx" where xxx = Numerals of version number, no decimal
point separator; e.g., V515 = Version 5.15.

z Note: “Firmware Version is shown on the display when you first turn the system

2. In the ControlMate software: If the sequence you want to run is not open, select
Open Sequence File '+ from the Toolbar, select the file you want to run, and

open the file.
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3. Click the plus sign next to Main Sequence in the command tree (and the plus sign

A

Getting Started: Automated Operation

next to Procedure Library if there is a plus sign) to display the commands and
procedures in the file.

[ Rearray(4)36to(1)384.cms

Title [Rearray (4) 96-well to [1) 384-well [ Editlock [T Furlock

%ﬁ.’ Main Sequence

! ﬁE Pracedure Library This iz the main command sequence. The commands
= in this section will be executed sequentially from the:
first command.

Review the commands/procedures to be sure that this is the file you wanted to
run.

Verify that checkmarks appear next to all of the commands and procedures you
want to execute during this run. Select (check) unmarked commands/procedures if
necessary.

Click the Run | # icon on the Toolbar. The software automatically runs a file-
validation procedure.

If there are any errors in the file, correct the errors and save the changes to the
file. Then click Run & again.

The Execute Sequence File screen appears.
[ Execute Sequence File M=l E3

Sequence file |Rieanmay(4136tal11384.cms

Last run date |
Last run duration |N I
Cstimated bme remaining I

Progress [

Start I Stam I Help |

| 7

=]
I

Click the Start button to start running the file. The stage (or tray table) moves to
home position for all applicable axes.

As the sequence file runs, the percentage of the run that is complete appears in the
Progress bar on the screen.

If the syringes are not down at their lowest (home) position, you will be prompted
to place a vessel in the stage 1 position. Put an empty reservoir or plate in the
position and then click OK. The syringes will empty, and then you will be
prompted to remove the reservoir or plate.

Caution: The syringes must be emptied before the system executes a sequence
file. Running a file without emptying the syringes might cause damage to the
system.
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10. If you receive a prompt to place labware in a position, place the labware in the
nest and then click OK to restart the run.

11. When the run is finished, click the close box on the Execute Sequence File
window and then click the close box on the Sequence File Editor screen.

Stopping or Pausing a Sequence File Run

To IMMEDIATELY STOP a sequence file run: Press the red button on the
Emergency Shutoff Switch.

EMERGENCY
op

2

To pause or stop the sequence file run from within the software: Click the Stop
button on the Execute Sequence File screen. On the Pause or Abort run execution
screen, click OK to restart the run or Cancel to end the run.
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Pages 4-45 through 4-68 provide reference information for the Main Sequence Editor

functions and the commands.

The Main Sequence Editor, with its Sequence File Editor window, is described first.
You will use the Main Sequence Editor to create and edit all your sequence files. The
parts of the Sequence File Editor screen and the editor’s functions—including add,
delete, move, cut, copy and paste commands— are described.

Descriptions of the commands follow the Main Sequence Editor information. The
command descriptions are listed in the order that they appear in the Toolbox and in

the Add Command dropdown list.

Call Procedure

Notepad

Group Commands

Execute External Application
Procedure

External Procedure File

Valve Control

Aspirate

Dispense

Move to Position

Movements to position for pipetting
Home Axes

Pause

Wash Needles

Mix

Message Display

Pump Control

Speed Control

Change DARTSs Tip Magazine Command

descriptions of these commands for more information.

Getting Started: Automated Operation

Note: *Main Sequence Editor, Procedure Library, and Valve Control do NOT
appear in the Add Command list or in the Toolbox. See the individual
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Main Sequence Editor

E’%(New) 9=l B3
T\tlel " Editlock =1 R [och

%%i Main Seguence =

This iz the main command sequence. The commands
in thiz zection will be executed sequentially fromr the
first command.

| Procedure Library

Set | Undo | flest .rur.-::'(-l Help I

| Hydra Il | | ? Sequencs unchecked | v Command: OK | i

The Main Sequence represents the main command sequence. It is called once during
file execution and is processed from the top down.

z Note: You must select the Main Sequence checkbox in the command tree to

execute the entire file.

Elements of the Sequence File Editor Window

Title Bar

E DiyDizplul _cms

Title [0y dispense Tul [V Editlock [~ Runlock

If the open sequence file is one that has already been saved, the title of the file (also
known as “file header”) appears in the bar at the top of the Sequence Editor window.
If the file has not been saved, then that bar contains <New>.

Title—A text entry used to label the file for captions and reports.

Edit and Run Locks—The edit and run lock dialogs are used to control access to
sequence file editing and execution. Once a lock has been set, the correct password is
required to enable access to all file functions. This means that it is possible to create
sequence files and then set an edit lock to prevent a file from being changed. This is
useful when creating file templates where the new files are created based on existing
ones. An edit locked program can be opened “read-only” without a password and
then saved under a new file name using the “save as” function.
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Setting the run lock will prompt the user for a password and then for confirmation of
the password. If the two password entries do not match then the lock is not set.

z Note: Passwords are case-sensitive.

Status Bar

| Open fles [1] E Clipboard active |.-’-'«ut0 carect: On | Current file 'demoProgram.cms' 4

The status bar is located at the bottom of the Sequence Editor screen and provides
information relating to the sequence file that is currently open.

Module—The first panel of the status bar displays the instrument name (the name of
the device) to which the commands relate.

Changed Status—The second panel shows the current edit status of the file and
displays whether or not any changes have been made since the sequence was last
saved.

Sequence Validation—The third panel indicates whether the entire sequence has been
checked for validation and whether the validation has passed or failed. The sequence
validation looks at the command relationships rather than the individual limit values
of commands. This type of validation is useful for determining total volume levels,
and so on, throughout the sequence. You run a sequence validation by selecting either
Validate File or Run from the Run menu.

Command Validation—The fourth panel provides status on the validation of
individual commands—for example, if you entered an incorrect height value or a
volume value that exceeds the volume limit of the syringes. If any commands contain
such errors, this panel displays the text “command errors.” You can identify
commands within the main sequence that have been detected as invalid by a large red
cross that appears over the command icon in the command tree. If no errors are
present, the panel reads “Commands OK.”

Last Run Information—The duration and date of the last run (if applicable) for the
respective file is displayed in this last panel. Determining run time is useful for
workload planning.

Command Buttons

Located at the bottom of the edit field screen for each command are the following
command buttons:

Set—Refreshes the screen and updates the tree structure with the changes made to the
command being edited. The changes are not saved to the file until a save file option
has been selected. Values are checked for validation against the rules (which can be
set in Tools> Options) before they are written to the tree structure. Any validation
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errors are displayed in a frame within the command edit screen. The icon in the tree
structure is also overlaid with a red cross to indicate invalidity.

Undo—Changes the settings back to the original values prior to the current edit.

Test mode—(Available for Move commands.) Allows the values for the command to
be tested on the device by restricting the editor to the current command only. Any
changes made are then sent directly to the device. This is useful, for example, for the
testing of heights and positions. To return from this mode select the button again (it
will now show Edit Mode as a caption).

Help—Displays help for the respective command.

Command Tree

The command tree represents the program sequence that you create by inserting
commands below the “Main Sequence” title. Sequence files are executed from the top
to the bottom of this tree structure. Commands can be manipulated in the tree
structure in a number of different ways.

Adding, Deleting, Moving, Cutting, Copying and Pasting Commands

Add a command:
1. Click (highlight) the command below which you want to add a command.

2. Do ONE of the following:

¢ Right-click the highlighted command. Select Add from the dropdown menu
and select the command you want to add:

- o
YT Cal Procedurs

Delete

Group Commands
Execute External Applcation

Lot
Copy

Pt Procedure
=% Estemal Procedure File
Azpirate
H2 0
Dizpenze
. . Maowve to Positi
Dispense in G2 Tl
Home Axes
L h Call Procedurs Prc Pause
[P “Wazh Tips
iz

Meszage Display

_ ﬁ Dispense in 03 Pump Caontral
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¢ OR: Click the icon for the command you want in the Toolbox.

- 4
P
Call Notepad

T’"

i

Procedure  Zxtemal

- ﬁ Plate #1

: | i -
Group  Execute : EE ﬁ- Dizgpenze in 01
: =
5 B i [
@ @ : ﬂﬂ Call Procedurs Procedurs ‘W ash

T ——

Title [ e.array from (4) S6well to (1) 354 well [ 1

® OR: Select the command from the Add Command dropdown menu on the

Toolbar.

Run Tool: Addin: “Window Help

Bl X ||__<3;.|

Call Procedurs
Title Reanay fram (4) Hl=akl]

= Main | P e e

1 Asplrate

As each new command is added to the tree on the left side of the Sequence
File Editor screen, the edit fields for that highlighted command are available
on the right side of the screen. You can expand or reduce either side of the

Group Commands
Execute External App_|

External Procedure Fi

screen by clicking and dragging the bar that divides the sides.

Delete a command:

1. Click (highlight) the command you want to delete.

2. Do ONE of the following:

¢ Right-click the highlighted command and select Delete from the dropdown

list.

¢ OR: Press the Delete key on the keyboard.

¢ OR: Click the Delete icon }"f on the Toolbar.

Move a command:

1. Click (highlight) the command you want to move and, while keeping the left
mouse button pressed, drag it to the new position.

2. Release the mouse button.

You can also use Cut, Copy and Paste buttons to move commands.

Getting Started: Automated Operation
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Cut, Copy, and Paste commands:

You can cut, copy and paste commands in the command tree to or from the
Clipboard. These features allow you to save time by copying and editing existing
commands rather than recreating them manually. For example, if you would like to
dispense the same volume into all four quadrants of a 384-well plate using a 96-
syringe head, create a group command for the first quadrant. Then copy the group
command, paste it three times, and edit only the quadrant information within each
new pasted group command.

If the current command is a group command such as Main Sequence, Group
Commands or Procedure, then all child commands will follow the same action as
their parent.

Cut a command:
1. Click (highlight) the command you want to cut.

2. Do ONE of the following:
¢ Right-click the highlighted command and select Cut from the dropdown list.
¢ OR: Click the Cut icon .;lﬁlg on the Toolbar.
When you cut a command, it is saved on the Clipboard until you cut or copy

another item.

Copy a command (or commands):
1. Click (highlight) the command you want to cut.

2. Do ONE of the following:
¢ Right-click the highlighted command and select Copy from the dropdown list.

® OR: Click the Copy icon on the Toolbar.

Paste a command (or commands):
1. Click (highlight) the command after which the new command is to be pasted.

2. Do ONE of the following:
e Right-click the highlighted command and select Paste from the dropdown list.

¢ OR: Click the Paste icon E on the Toolbar.
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Select Commands to be Included or Excluded From Execution

You can exclude or include individual commands or command groups from
execution. To prevent a command from executing when the sequence file runs,
uncheck the box beside the icon of that command in the tree. NOTE: Checking (or
unchecking) a group command will cause the child commands of that command to
also be checked (or unchecked). The following example shows an unchecked group
command:

+ ..
= % M to Position 4 |: St
D I ' ove [0 Fosion Yeszel ag

&+ .
4 & Move to Pipettor: Stage 1
Ol%s St

¢
---------- Agzpirate 20ul Overstroke
O I_l

Procedure Library

Procedure Library

A procedure containg a group of commands which
can be called as required. The procedure iz not
included in the general sequential processing of
commands and has to be specifically callzd using the
‘Cal’ cormmand. Once the commands in £ procedure
have bzen processed the program will then continue
proceszing the commands immediately folowing the
'Call' cormmand.

The procedure section contains all of the procedures that exist within the current
sequence file. The procedure section is not executed during file execution. Procedures
contained within this section can be called either within the current file main
sequence structure (internal call) or from another file (external call).
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Call Procedure

-
iy Call Procedure

¥ I this file
™ In adifferent file
= Extemnal File
Filernam= I
Path |
|ead st |

Groups | LI
Procedure !None zelected ;i

This command allows the inclusion of a selected procedure within the main sequence
file, thus allowing creation of standard procedures. For example, a procedure for
aspirating an entire plate could be called from another program without having to
redefine parameters. Using this command reduces time needed to create sequence
files. The Call Procedure command allows procedures to be included either from the
library of procedures within the current sequence file or from another sequence file.

Fields

In this file—Populates the Procedure field (after “Local procedures” is selected from
Groups) with the procedures within the current sequence file.

In a different file—Populates the Procedure field (after the external sequence file is
selected and Load List is clicked) with procedures from that external sequence file.

Filename—Displays the selected file name (if calling a procedure from a different
file).
Path—Displays the file path (if calling a procedure from a different file).

Groups—If In this file is selected, includes the list item “Local procedures.

Procedure— If In this file is selected and “Local procedures” has been selected from
Groups, lists procedures within this sequence file. If In a different file is selected and
Load List has been clicked, lists procedures within the external file. You select the
procedure you want to call from this list.
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Notepad

Notepad

Ilge this space to provide comments about the sequence]

This command is used to create a note entry within the sequence file. The Notepad
command is useful for documenting the reason for command values and positioning
and for reminders of device configurations for specific sequence files, etc. The
content of the notepad has no effect on the sequence file during file execution.

Group Commands
Group Commands

Title |

Laop |-| iterations

A command group represents a collection of commands. This command allows you to
group two or more commands that are used together to perform a task. For example, a
group command could represent the copying of samples from a block; another group
command could represent the dilution of a block.

Fields

Title—Allows the entry of a text value that represents a name for the group.
Loop—Allows the setting of a value that represents the number of iterations that the
group is to be processed. Command execution proceeds to the command following

the group command after the loop has been processed the number of times specified
by this value.
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Execute External Application
E Execute External Application

—Application
Filename |

Select

Parameters |

Wait until complete W

~Window
i ‘isible
Size & MNomal (" Minimized Maximized

" Hidden

Mezsage to display

This command allows an external application to be called during sequence file
execution. This command might be used, for example, to execute an application that
controls an alarm, sends an E-mail message to an administrator, or starts the
Microsoft Excel program.

The fields allow you to specify whether the software is to wait for an application to
finish (that is, until the application’s window is closed) before continuing with the
sequence file execution or to continue immediately. You can also set the way in
which the applications window is displayed or even choose not to display the
window.

Fields

Filename—The full path and file name of the application to execute. Use the Select
button to choose the file from a file selection dialog window.

Parameters—Additional parameters that are passed to the application when it is
loaded. For example, if the application being called is “C:\Windows\Notepad.exe,”
then the parameters field might contain the name of a file to open when Notepad
starts.

Wait until complete—If checked, specifies that sequence file execution is paused until
the application finishes executing or until its dialog window is closed. If unchecked,
causes the program to load the specified application and then immediately continue
with sequence file execution, leaving the application running.

Visible—Specifies that the application is to display a dialog.

Size: Normal, Minimized or Maximized—These fields are available for selection if
Visible is selected. Only one field of the three can be selected. It specifies the initial
window size of the application window.
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Hidden—Selecting this field deselects the Visible option. If Hidden is selected, the
application is loaded without showing any window dialog. This option is useful, for
example, if the application requires no user interaction; it reduces screen clutter.

Message to display—Selecting the Hidden field enables this field. It is optionally
used to display a message window to inform a user that the selected application is
running or to provide the user with other relevant information.

Procedure

?@ Procedure

Tils Uil

A procedure contains a group of commands that are executed whenever the procedure
is called from a main sequence structure. The call can be made from the current
sequence file (internal call) or from another sequence file (external call). During file
execution, any commands contained within a called procedure will be executed as if
they existed within the main program structure.

This command allows the creation of standard procedures. For example, commands
for aspirating or dispensing an entire plate could be called from other files without
having to redefine the parameters, thereby reducing the time needed to create
sequence files.

Fields

Title—A text field that can be used to represent the name of the procedure. If the text
entered is the same as the text for another procedure in the procedure collection, an
index value is appended to the text; for example:

e Main Sequence
k¥
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External Procedure File
@ External Procedure File

Filename | Celect |

Fath |

File date I File: time I

Check file dateftime [~

A procedure contains a group of commands that are executed whenever the procedure
is called from a Main Sequence structure. Using this command will import all
procedures contained within an external sequence file into the current file; those
imported procedures will be grouped under this command heading. The procedures
can then be called from the current sequence file (internal call). During file execution,
any commands contained within a called procedure will be executed as if they existed
within the main program structure.

This command allows the creation of standard procedures. For example, commands
for aspirating or dispensing an entire plate could be called from other files without
having to redefine the parameters, thereby reducing the time needed to create
sequence files.

Fields
Filename—The name of the file containing the required procedures.

Path—The file path for the file to be included.
File date/File time—The last modified date and time stamp of the required file.

Check file date/time—A message is displayed when the current file date and time is
different from the file date and time when the file was last referenced in this sequence
file. If this checkbox is checked, the command also displays a validation error
message and prevents the sequence file from being executed unless this external
procedure file is re-imported.

Valve Control

Allows a VALCO multi position actuator to be directly controlled within a file
sequence. The file sequence pauses whilst the actuator selects the required valve
position before continuing with execution.

The Valve Control command is not installed during a standard ControlMate
installation. To have the Valve Control command made available a custom
installation must be selected during the initial installation. Alternatively it is possible
to install this feature by reinstalling ControlMate and selecting to install an additional
module.
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Fields
Type—The VALCO actuator model type.

Serial Port—The RS232 serial port to which the actuator is attached.

Switch ID—The specific actuator device id. This may not have been set. If a single
actuator is used then VICI recommends that the id is not set; in this case choose
‘None’. If a device id has been set and a number of actuators are attached to the
RS232 serial port then it is possible to set the position for all actuators simultaneously
by selecting the ‘All’ value.

Valve position—Used to determine which valve position to make current.

Direction—The movement from the current position to the desired position requires
the actuator rotating the valves. Use this field to determine the direction of rotation
‘Clockwise’ or ‘Counter clockwise’. It is possible to allow the actuator itself to
determine the quickest direction automatically by selecting the ‘Quickest’ value.

Aspirate
‘j’ Aspirate
Dverstioke [ "-"-'J!urm:-!_“._ ul

Pre airgap [ ".'-:-l-,1:-'-.=-Wi’J ul

YWalume W :—;JJ ul

Dwelltie [0~ = 1/100 seconds

Tiptouch T Action | didalah d

This command aspirates a volume. The command causes the piston motor to move
the plungers upward in the syringe barrels, thereby aspirating the given volume. The
aspiration is immediate and therefore requires the use of a preceding Move command
to ensure that a vessel is positioned below the dispensing head. Checks exist to ensure
that the piston does not over-aspirate and therefore stays within the maximum volume
limit defined for the current piston head.

Fields

Overstroke—Check this box if the aspirate is the first aspirate prior to multiple
dispenses. The selection of this option ensures that the piston motor is primed and
improves volumetric accuracy throughout all subsequent dispense aliquots. The
Overstroke volume is set on the Set Device and Pipettor Options screen under the
Add-Ins menu. You can set the Overstroke value and its accompanying spitback
volume to O (zero) on that screen if you wish to disable the Overstroke option.
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Pre air gap—Aspirates an air gap at the top of the syringe barrel. Aids in single
transfers of small volumes. See detailed information about the use of air gaps on page
6-5. (Air-gap maximum volume is set on the Set Device and Pipettor Options screen
under the Add-Ins menu.)

Volume—Liquid volume to be aspirated. Use the increment and decrement buttons to
change the volume value.

Dwell time—Specifies a period of time over which to leave the needle tips in the
sample immediately after the aspirate step.

Tip touch—Causes the tips to be touched against the top of the well after aspiration to
remove liquid, which may have adhered to the side or bottom of the tips. Note: Tip
touch is executed near to the chosen vessel’s well top, the height of which can be
adjusted via the Tip Touch Z offset value in Tools>Options>Plates.

Tips for using the Aspirate command:

m Aspirating with Overstroke on the first volume ensures that the piston motor is
primed. This is especially useful when aspirating small volumes and works to
ensure consistency and accuracy throughout a series of incremental dispenses.
Aspirating with Overstroke is required when smaller aliquots are to be dispensed
after a large volume aspiration.

m If a small amount of liquid is to be withdrawn and delivered, we recommend that
you insert a pre air gap to ensure that all of the liquid is expelled from the needles.
See page 6-9 for information about recommended air-gap volumes.

m If you are pooling samples from a 384-well (on a Hydra DT 96 system only) or a
1536-well plate (on a Hydra DT 384 system only), different volumes can be
aspirated from the different quadrants. You have to use a different Move
to/Aspirate command combination for each quadrant.

A Caution: The Aspirate volume must be sufficient to dispense the amount called
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Dispense

|ﬁ| Dispense
Valumne Al
Specific I.'. N :!.! ul
Dwell time |0 ﬁ 1/100 seconds
Tiptouch [~ Achion I aidaan ;I

This command dispenses either a measured volume or all of the liquid in the syringes
(as specified in the command). The command causes the piston motor to move the
plungers down in the syringe barrels to dispense the given volume. The action is
immediate and therefore requires the use of a preceding Move command to ensure
that a vessel is positioned below the dispensing head.

Fields

All—If selected, dispenses all liquid in the syringes. This does not perform a piston
reset at the end of the action.

Specific—If selected, dispenses the volume specified in the adjacent field. Use the
increment and decrement buttons to change the volume value. Note: Choose this
option when dispensing small aliquots after an aspiration with Overstroke.

Dwell time—Specifies a period of time over which to leave the needle tips in the
sample immediately after the dispense step.

Tip touch—Causes the tips to touch one or more designated points on the sides of the
wells, to dispense liquid at those points. Note: Tip touch is executed near to the
chosen vessel’s well top, the height of which can be adjusted via the Tip Touch Z
offset value in Tools>Options>Plates.

Tips for using the Dispense command:

m For a 384-well (on a Hydra DT 96 system only) or a 1536-well plate (on a Hydra
DT 384 system only), different volumes can be dispensed into the different
quadrants. You have to use a different Move to/Dispense command combination
for each quadrant.

m For best performance in low-volume dispensing, dispense some liquid in the
syringes back into the source plate before dispensing into the destination plate.
To do this, use the Overstroke option in the Aspirate command that precedes the
dispense.
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Move to Position

ffet+ Move to Position

Pasition IPipettor: Stage 1 l]
Weszel byoe ISB well flat (4915/4916/4922-29] j

Check veszel holder sensor - [

Height (v Preset ImWeIItop ,I

" Specific :1-' 1100 mm
Huadran ID 1 vi
Tipfwell oifset | @ Fredei=nd ||'_| Side top left vl

i Iﬁl :j'l 14100 mm
T II:I :j'l 14100 mm

This command is used to position either of the stage nests at a pre-set position. The
nests are identified by the position number, with source nest (stage position 1) being
on the left (as viewed from the front of the device) and destination nest (stage
position 2) on the right. The movements are grouped into two position types:

m Position a nest under the dispensing head

m Position a nest at a place forward of the dispensing head—for example, when
filling plates with solutions

The Move command is a very important command, because all actions require the
positioning of a nest or the tray table (the latter is positioned along a Z axis only; its X
and Y axes are static). It is therefore possible to test the actions of a Move command
when editing a sequence file by clicking the Test mode button on the Sequence File
Editor dialog window.

Movements to position for pipetting

Fields
Position—Sets the stage position. Other field parameter availability is dependent on
the position selected.

Vessel type—Specifies the vessel type (“vessel” = “labware”) that is situated at the
target location. Different vessel types have different settings for the other fields
within this command. The values for this dropdown list are created in the
Tools>Options>Plates dialog.

pieces of labware that your system configuration (referring to device type and
syringe count) allows. For example, if your system has 96 syringes and does
NOT include either the X/Y Plate Stage, then the labware list will include only
labware pieces that contain either 96 wells or one large well (reservoir) that
accommodates all 96 tips.

z Note: The labware choices that populate the dropdown Vessel type list are those
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Height—Specifies the height to which the stage or tray table should be raised.
Heights can be set either by choosing one of the preset heights (which are determined
by the vessel type parameters) or by specifying a specific height value. Movement is
measured from the position at the base of the stage or tray table from its zero position
upwards.

Quadrant—[on Hydra DT with X/Y Plate Stage only] If the combination of vessel
well count and syringe count allows for movement to different quadrants within a
vessel, then this field is available. Quadrant offset values are entered in the
Tools>Options>Plates dialog for the respective vessel.

Tip/well offset—[on Hydra DT with X/Y Plate Stage only] It may be necessary to
position the tips away from the center of each well. For example, when using 384-
well plates with low volumes, the greatest accuracy might be provided by positioning
the needle tips to touch off in one of the well corners. Checking this field will allow
the setting of tip positioning either by choosing one of the pre-set positions or by
entering X- and Y-axis offset values. See the Tools>Options>Positions dialog for
more information on entering offset values.

Home Axes
ﬁ Home Axes

W  PFistan
V¥  StageZ
¥  StageZ. % and'

This command can be used to reset the X, Y, and Z axes to their home position during
file execution.

Fields
Piston—Resets the piston (syringe plunger) motor.

Caution: This reset will cause any liquid in the tips at the time to be dispensed
immediately. It is therefore advisable to position a vessel (such as a reservoir)
under the tips before executing this command.

Stage Z—Resets the Z axis.
Stage Z, X and Y—Resets the X, Y and Z axes.
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Pause

Pause

i+ Dwration 1 ﬁ reconds

I Sound alam when pause complete
i Wait for uzer

Inserting a pause command into a program causes the device to stop processing
according to the pause parameters. After the continue condition has been reached, the
program continues at the next step within the sequence.

There are two types of pauses. These are:
m  Time based

m Infinite—requiring a user to specify when to resume

Fields
Duration—Causes the device to pause for a set timed interval.

Seconds (duration)—If checked, specifies the time interval over which to pause if
Duration has been selected.

Sound alarm when pause complete—Sounds an alarm on the internal speaker on the
PC 5 times after the pause period has expired.

Wait for user—Pauses the device indefinitely and requires the user to select, via a
window dialog, when to continue.
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Wash Needles
% Wash Needles

Wash Location
" Auto wash module

% UszexY stage positioner bazed wash vessel

Position |Pipettor: Stage 1 j
Wesszel lype |><Y stage top wash vessel j
Wash

Cyeles ’2_j Yalume |30 jlﬂ

Pump usage sequence

First & Pumpl  Pump2

Fill cycles |4 j
Fill time: 10 j seconds

Second [T & -

’—4

=

’—4

I

Drair time 14 j seconds

The Wash Needles command facilitates the washing of both the inside and outside of
each tip loaded in the tip magazine. The command can use a wash vessel on the stage
or, via a wash vessel placed on the XY stage positioner.

The command requires a preceding Move command to position the tips at the wash
vessel position and also for ensuring that a wash vessel type has been selected.

Fields

The fields in the command are grouped into 3 sections; Wash Location: which allow
the user to specify which wash vessel and wash location should be used; Wash which
allows the number of wash cycles to follow; Pump usage sequence which allows the
pump usage order to be specified.

Fields relating to Wash Location

Auto wash module

Selecting this field will use the inbuilt wash sequence within the firmware. The wash
vessel location used is that which is underneath the XY stage positioner. This field is
not available if the device does not have an auto wash module installed. During file
execution, the Hydra DT device controls the XY stage and piston movements, using
the parameters entered in the fields within this command.

Use XY stage positioner based wash vessel

Selecting this option will us a wash vessel to be placed on top of the XY stage
positioner. This field is not available if the currently selected needles or DARTS tips
cannot be washed using an XY stage positioner based vessel. During file execution,
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ControlMate will directly control all XY stage and piston movements, using the
parameters entered in the fields within this command.

Fields Relating to Wash Cycle

Cycles
This field is used for defining the number of wash cycles required.

Volume

The liquid volume to be aspirated and dispensed during each wash cycle. The
increment and decrement buttons will change the volume value accordingly. The
increment for these actions can be set via the Set Device or Pipettor options Add-In

Fields Relating to Pump Usage Sequence-
Please note: These functions are not available for the Hydra DT

Pump usage sequence
The Pump usage sequence fields are used to specify the pump usage during the each
wash cycle

First/Second

These fields specify, within each cycle, whether to use one or both pumps. The First
pump set of fields is mandatory since the cycle has to at least run one set of pumps.
The Second is therefore optional and is used if, for example, two different liquids are
required for washing during each wash cycle.

Pump1/Pump?2
Specified which pump within the wash module to use.

Fill cycles
Specifies the number of times the pump is to be used within the current cycle. This is
used in conjunction with the drain pump usage.

Fill time
Specifies how long, in seconds, the fill pump is to run before the drain pump is
switched on.

Drain time
Specifies how long, in seconds, the drain pump is to run.

1. Fill pump 1 activates and fills the Wash Reservoir with wash solution.

2. The syringes aspirate and dispense 10uL from—and back into—the Wash
Reservoir 3 times.

3. The drain pump empties the reservoir.
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4. Steps 1 through 3 are repeated 2 more times (because Fill cycles for Pump 1 is set
to 3).

e Fill time—Specifies how long, in seconds, the fill pump is to run.

® Drain time—Specifies how long, in seconds, the drain pump is to run.

because they do not include the Wash Pump Module. For those systems, use a
Mix command to execute a Manual Wash operation. See more about Manual
Woash in the “Tips” section of this command description.

z Note: This command cannot be used with Hydra DT base-unit only systems,

Tips for using the Wash Needles command:
The syringes can be washed manually and automatically.

using a reservoir (single-well piece of labware) in the source nest or on the tray
table. During the wash procedure, the reservoir is placed under the dispensing
head and the tips are cleaned with the number of up/ down strokes (mix cycles)
specified. Fill the reservoir with the wash solution before you begin the wash
procedure.

i T Note: Use the Mix command to do a Manual Wash. A Manual Wash takes place

See also: Mix command, page 4-65; Pump Control command, page 4-67.

Mix
G M
Cycles I‘I_:fj
Yolume 0100 =1y

izl

Aznitate hright ||:| Wwicll top '!
Dizpenze height ||1| Wwiell top 'i

This command can be used to aspirate and then dispense liquid in a vessel to re-
suspend material in the vessel so that a homogenous solution can be created prior to a
subsequent aspiration.

The Mix command can be used to aspirate/dispense liquid in a vessel to re-suspend
material in the vessel so that a homogenous solution can be created prior to
aspiration.

The Mix command can also be used to wash the D.A.R.T.s on Hydra DT systems that
do not include the Wash Pump Module or in instances where the standard wash
routine is not required. See page 4-65 for details about using the Mix command for
these purposes.
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This command requires a preceding Move command to ensure that the vessel is
positioned under the dispensing head.

Fields

Cycles—Specifies the number of mix cycles. (One cycle is one aspirate plus an
immediately following dispense.)

Volume— Specifies liquid volume to be aspirated and dispensed during each mix
cycle. Use the increment and decrement buttons to change the volume value.

Aspirate height—Specifies the tray table/stage height at which aspiration occurs.
Choose one of four pre-set heights (heights are set during labware calibration).

Dispense height—Specifies the tray table/stage height at which dispense occurs.
Choose one of four pre-set heights (heights are set during labware calibration).

Message Display
! Message Display

Mode " Mommal display

% Custom message

Message

This command allows a custom message to be displayed on the Hydra DT display
panel at the top front of the microdispenser.

Fields

Normal display—Returns display to its original display, the one that appeared on the
LCD display before the Message Display command was executed.

Custom message—Allows user to type message into screen area that will then be
displayed on the display panel. The character limit of the message is the number of
characters that fit on the four text lines.
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Pump Control

ﬁ_}:
o

* Pumpl

Pump Control

& Mump 2
= Dirain
Duration !10 j seconds

Note: This command is not available for use with the Hydra DT

This command allows you to control the pumps directly, independent of a wash
routine. You might want to use this command, for example, if you wanted to fill the
Wash Reservoir with a buffer solution but did not want any wash cycles to be
performed.

The pumps can be used to fill or empty wash or other appropriate vessels for a user
specified duration (in seconds).

A Move command must precede a Pump Control command to ensure that a reservoir
vessel is positioned at the dispensing location. The Move command must have the
Wash position specified. The software prevents the file from executing if this Move
command is omitted.

Fields

Pump—Pump1/Pump2/Drain—Selects the associated pump to use. (“Drain” is
Pump 3, or the “Empty” pump.)

Duration—A specified duration (in seconds) after which time the pump will
automatically deactivate. Default is set to 10 seconds.

Speed Control
Eﬁﬁ Speed Control

Azpirate [ Slow —j— Fast
Dizpence [ Slow ——— Fast
Empty ¥ Slow —_——— Fat
Wash v Slow [—————— " Fayt

The piston (syringe-plunger) speeds for Aspirate, Dispense, Empty, and Wash
operations can be adjusted using the Speed Control command.

To set a speed, click the check box for the respective action and then use the slider to
set the required speed.
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A speed setting used in a sequence file is used for that action type until another speed
control command is encountered in the sequence during file execution.

Tips for using the Speed Control command:

Reducing piston speed is recommended for improving accuracy and precision for
high-viscosity liquids.

Change DARTSs Tip Magazine Command

ﬁ»ﬁ Change DARTs Tip Magazine

DARTs bype |DAF|TS 9E 1.0ul - 20ul lang tips (5506+5507) j

Track usage W Change after |10 j uses

This command is used to pause the sequence file execution in order for the DARTs
tip magazine to be replaced. The command has the ability to check and issue the
instruction to pause and replace tips each time it is called within a program sequence
or by an incremental counter to check the usage. To use the incremental counter, the
command must exist in a command Group that uses iterations.

During File Execution, a window dialogue prompt is displayed on the screen
prompting the user to replace the DARTS tip magazine. The user is then required to
click the OK button to continue with the rest of the protocol sequence.

Fields

DARTs type

This field is used to specify the DARTS tip type to use. By default, the one that is
specified in the Add-In : Set Device and Pipettor Options is highlighted. During File
Execution, once the user has changed the DARTS tip magazine and clicked the OK
button to continue, the Add-In : Set Device and Pipettor Options field value is
changed to the one specified in this command.

Track usage
This sets an internal counter that determines when tips should be changed within a
loop. The counter is set to 1 at the start of every file execution.

Change after (n) uses
This determines the internal tip change counter. This field is only displayed if the
Track usage check box has been checked.
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ControlMate OLE Optional Add-On Software Component

ControlMate OLE is an optional, add-on software component. It provides an
application developer with an ActiveX®? COM automation interface for the
ControlMate device-control application. The component enables an application to
instantiate an object that can load, modify, and execute ControlMate sequence files.

The calls made to the ControlMate components do not require loading the
ControlMate application into memory.

A powerful feature of ControlMate OLE is the ability it provides to dynamically
change and set command field values within a sequence file. This ability allows the
integration of information such as source values (for example, aspiration volumes)
that have been extrapolated from databases.

The ControlMate OLE component has been developed for use with Microsoft®
Visual Basic® versions 5 and 6.

For information about ordering the ControlMate OLE component (cat. no. 501-
30023), go to the Matrix Technologies web site at http:/ /www.matrixtechcorp.com/
and access the price list.

2 ActiveX is a registered trademark of Microsoft Corporation.
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Overview of Service and Maintenance Tasks

To keep your Hydra DT microdispenser in its best working order, you need to
provide regular service and maintenance. This chapter describes basic service and
maintenance tasks for the Hydra DT microdispenser. These tasks are listed in Table
5-1 on page 5-2. You do not need to call your equipment provider for help with the
problem before performing the service and maintenance tasks listed in Table 5-1.

Note: If you need to perform a service or maintenance task that does NOT
appear in Table 5-1 on page 5-2, please contact your equipment provider before
performing the task. See page 1-9 for contact information.

Table 5-1: Service and Maintenance Tasks for the Hydra DT
Microdispenser

Task Frequency | Task Indicators that service is needed... See ...
Weekly C_heck PTFE ¢ Unit dispenses uneven volumes. page 5-4
tips e Plungers above tips or areas

between tip divisions are discolored.
e Liquid is visible above the tips.
e Liquid is dripping from the needles.

R_eplace PTFE | e Unit dispenses uneven volumes. page 5-5
Tips e Plungers above tips or areas
between tip divisions are discolored.
e Liquid is visible above the tips.
e Liquid is dripping from the tips.
Note: Heavy use = many operations
daily; Moderate = few operations daily;
Light = few operations weekly

Use: Heavy: 2-3 Replace ¢ Needles are bent or broken. page 5-7
mos. Modergte: syringes « Syringe performance is

6-12 mos. Light: unacceptable.

12+ mos.

¢ Syringe barrel is cracked or broken.

Check & When you press the power switch to page 5-15
replace fuses ON:

¢ System does not turn on. (Check
power-module fuses.)

¢ System turns on but LED display
does not come on, green light on
controller board does not blink, and
motors do not move. (Check logic
power supply fuse.)

e System turns on, LED display comes
on, green light on controller board
blinks, but motors do not move.
(Check motor power supply fuse.)
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Contact Us If You Have Service or Maintenance

Questions

If you have any questions about the service or maintenance of your Hydra DT
microdispenser, please contact your equipment provider. See page 1-9 for contact

information.

How to Return the Microdispenser or Microdispenser
Parts for Service or Repair

Please see page vi for a detailed description of how to return the microdispenser or
microdispenser parts for service or repair.

Table 5-2: Chemical Reagents Used Routinely With Hydra DT Systems

Acetic acid Dimethyl Formamide Triethylamine

Acetone Dimethyl Sulfoxide Toluene

Acetonitrile Ethanol Trifluoroacetic Acid
Ammonia 27-30% Hexane Trimethyl Orthoformate
Chloroform Methanol Xylenes
Dichloroethane Methylene Chloride Toluene
Diisopropylamine Methylene Chloride/TFA, 1:1

Dimethylacetamide Pyridine

Guidelines for Manual Wash washes
Follow these guidelines for all Manual washes:

m  Use a wash volume that is equal to or greater than the sample volume.

m Change the wash solution for fresh solution after every 3 wash cycles.

a. [Manual Wash Only with no pump module] Wash the syringes with the
same base solvent as was used in your protocol, rather than dH,O, as the first
wash solution. Wash 3 wash cycles.

b. [Manual Wash Only with no pump module] Wash with methanol or

ethanol, 1 wash cycle.

Wash with dH,0, 3 wash cycles.

c. If washing between uses of DMSO: Wash the syringes with DMSO, rather
than dH 0, as the first wash solution, 3 wash cycles.

d. Wash with methanol:acetone (1:1 v/v), 1 wash cycle.

Service and Maintenance of the Hydra DT Microdispenser
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e. Wash with methanol or ethanol, 1 wash cycle.
f.  Wash with dH 0O, 3 wash cycles.

g. Wash with dH,O additional times if you prefer.
h. Wash with dH,0, 3 wash cycles.

Checking the PTFE Tips

The integrity of the PTFE tips on the syringe plungers is essential for precision
dispensing. You can prolong the life of the PTFE tips by following the proper
syringe-cleaning procedures and schedules.

Examine the PTFE tips weekly. If you see the following, change the tips
immediately:

m Liquid above the PTFE tip

m Liquid dripping from the needles

m Discoloration on the stainless steel plunger above the tip or between the divisions
of the tip

m  Unit is dispensing uneven volumes

barrels, do NOT replace the PTFE tips on your syringe plungers. Instead, send

2 Caution: If you see spotting of a reddish-brown precipitate inside syringe
the syringes to us for factory service.

Contact the Technical Service Department for more information regarding
preventative maintenance services provided

Generally, you will want to replace all the PTFE tips at the same time.

Typically the PTFE tips last six to twelve months. However, the life of the PTFE tips
varies with usage. Table 5-3 provides guidelines for tip replacement. Your
experience might vary from these parameters.

Table 5-3: PTFE Tip Replacement Guidelines

Usage Level Usage Definition Replacement Frequency
Light A few operations weekly 12+ months

Moderate A few operations daily 6 — 12 months

Heavy Many operations daily 2 — 3 months

See Replacing PTFE Tips, following, for instructions.
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Replacing PTFE Tips
Replace the PTFE tips as needed. See Table 5-3 for guidelines on when to replace the
tips.

Replace all the tips at once if you are replacing the tips for any of the following
reasons:

m  Unit is dispensing uneven volumes.
m Liquid is visible above the tips.

m Liquid is dripping from the needles.

Caution: If you see spotting of a reddish-brown precipitate inside syringe
barrels, do NOT replace the PTFE tips on your syringe plungers. Instead, send

the syringes to us for factory service.

If you replace a syringe, replace the PTFE tip as well (never use an old tip with a new
syringe).

Procedure 5-4: Replace PTFE tips on plungers

Before you start

Set up a Hydra DT EPROM file (one of the 16 files resident on the microdispenser) to
perform the operations described in this procedure.

Have these items ready to use:
m PTFE tip replacements
m Plunger Rod Tool

m Phillips-head screwdriver (Note: You will need a short screwdriver to remove the
head cover plate screws that are adjacent to the front of the microdispenser.)

Replacing the PTFE tips
1. Empty the tips by pressing Empty.

2. Set the Air parameter in an Aspirate command to maximum volume. Press Aspr
to fill the syringes with air.

3. Run the Empty operation to lower the head, but press the STOP button when the
head has lowered halfway to pause the operation. Having the head in this position
allows access to the plunger head buttons.

4. Turn off the power to the microdispenser.

Service and Maintenance of the Hydra DT Microdispenser
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5. Use a Phillips-head screwdriver to remove the screws from the head cover plate
and then remove the head cover plate. See Figure 5-1.

Figure 5-1: PTFE Tip Replacement (Showing Tip for 100uL Syringe)
6. Pull the plunger out of the head plate and syringe barrel.

7. Using the needle-nose pliers, carefully pull the PTFE tip from the plunger. Be
careful not to damage the plunger when removing the PTFE tip.

8. Place the new PTFE tip with the hole facing upward into the hole in the head
assembly. Press the plunger straight down into the PTFE tip. Make sure the PTFE
tip has been fully seated onto the plunger and that the PTFE tip has not been
damaged.

9. Place the plunger back into the head and syringe barrel. Slide the plunger up and
down the length of the syringe barrel. The plunger should travel smoothly through
the glass barrel. If the travel is not smooth, the PTFE tip might have been
damaged during insertion. Inspect the tip and replace it if necessary.

10. Replace the head cover plate and tighten the screws.
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Replacing Syringes

Syringe replacement will require that the Hydra DT pipettting head be removed first.
A case will be provided to send a Hydra DT syringe head to the Technical Service
Department for in-house services to be performed.

Please contact Matrix Technical Service Department for information regarding
preventative maintenance services.

Removing the syringe head from the Hydra tower.

1. Turn the power on and allow the syringe head to home. Install the 2 shipping
blocks on each side of the syringe head. Each shipping block is bolted through
the top of the syringe head using a 5/64-inch Allen wrench on the 2 button head
screws. Leave these blocks in place at all times while the syringe head is not
installed on the Hydra tower. See Figure 5-2 for shipping blocks and placement
onto Hydra DT syringe head.

Figure 5-2: (From Left to Right): Shipping blocks are supplied with the
syringe head case provided by the Technical Service department;
shipping block placement, shipping block bolt positions

2. Loosen and remove the 2 Phillips head screws to allow the baffle cover to be
taken off. See Figure 5-3.
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Figure 5-3: Top view of the Hydra DT tower Philip head screws to be removed
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3. Remove the 4 socket-head screws on the lower syringe head assembly with a
9/64-inch Allen wrench. See Figure 5-4 for socket screw positions.

Figure 5-4: Left and right views of the 4-socket head screws to be removed
on both sides of the Hydra DT syringe head

4. Remove the 7 socket-head screws on the syringe head top with a 5/32-inch Allen
wrench. See Figure 5-5.

Figure 5-5: Top view of the 7 socket head screws to be removed from syringe head
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5. Lift up on the entire syringe head assembly until it releases from the two
mounting pins on the Hydra tower. Do not lift or carry the syringe head by the
clamping handle. See Figure 5-6 for proper lifting technique.

Figure 5-6: Lifting the syringe head from the Hydra DT tower

6. If you are sending the Hydra DT head in for repair or Preventative Maintenance
and calibration, see the section Sending in your DT head on page 5-14. If you are
replacing a syringe or syringes, go on to the next section.

Syringe Head Disassembly and Syringe Removal

1. Lay the syringe head on its back. The lower portion of the head will need to be
propped up so that the head lies flat (two normal well plates stacked are the
perfect height). See Figure 5-7.

Figure 5-7: Hydra DT syringe head positioned on its back stacked
on 2 standard height plates
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2. Remove the two lower flathead screws on the handle assembly (there is one on
each side of the syringe head). The tip magazine C clamp will now slide out
easily. See Figure 5-8 for flathead screws to be removed and view of C-clamp.

Figure 5-8: Side view of Hydra syringe head flat head screws and
bottom view of syringe head C Clamp to be removed.

3. Remove the six bolts that attach the silicone pad bracket to the syringe head. The
pad bracket can now be removed. See Figure 5-9.

Figure 5-9: Silicon pad bracket
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4. Using a 3/32 inch Allen wrench, remove the twelve socket-head cover bolts. See
Figure 5-10.

Note: You may need a small flathead screwdriver to remove the cover from
the syringe head.

Figure 5-10: Syringe head cover and bolts to be removed

5. Push the plunger rod tool through the bottom of the glass barrel until it meets with
the Teflon tip. Slightly push on the Teflon tip until you can see the corresponding
plunger move above the top of the head. Grasp the plunger top with your free
hand and pull it out slightly more. Push down on the plunger until you can take
hold of the glass barrel. Separate the glass barrel from the plunger. Continue this
until you have removed all syringes necessary. See Figure 5-11 for removing
syringes.

Figure 5-11 (left to right): Inserting plunger rod tool into bottom of glass barrel;
removing syringes.
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Installing a New Syringe

1. Take a new syringe and remove the plunger from the barrel.
2. With one hand, slide the glass barrel through the barrel guide.

3. With the opposite hand, place the new plunger through the top of the piston
retainer head, and push it into the barrel. Support the base of the glass barrel and
raise the new syringe so that its base is even with the bases of the other syringes.
Push the plunger until it is flush with the piston retainer head.

4. Once all of the syringes are replaced, you can re-install the silicone pad holder.
Be sure to place the white silicone pad on the bottom, the compression plate in the
middle, and the blue silicone pad on top. The beveled edge of the pad holder
should be in the front position of the syringe head. See Figure 5-12 for silicone
pad installation order.

pad. Tighten the 6 flat-head screws. Do not over tighten the screws.

z Note: Make sure that the syringe barrels line up with the holes in the silicone

Figure 5-12 (From left to right): Blue silicone pad, compression plate,
white silicone pad and silicone pad holder.

5. Reposition the head plate cover and install the 12 socket-head screws carefully.
Tighten them in pairs, and refrain from creating too much pressure on one screw.

ZNote: Do not over tighten the screws.

6. The tip magazine holder C clamp can now be re-installed. Slide the two pistons
through the piston guides. Re-attach and tighten the two flat head screws to the
handle assembly. Do not over tighten the screws. Your DT head is ready to be
attached to the Hydra tower.
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Attaching the syringe head to the Hydra Tower

1. Align the top of the head with the two guide pins on the syringe head back plate.
The syringe head should slide in place with minimal force. See Figure 5-13 for
replacing the syringe head on Hydra DT tower.
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Figure 5-13: Guide pins to align syringe head with for reattachment
on Hydra DT tower.

2. Reinsert the 7 socket-head screws on the syringe head top and tighten them with a
5/32-inch Allen wrench. Do not over tighten the screws. See Figure 5-5.

3. Reinsert the 4 socket head screws that hold the lower portion of the syringe head
and tighten them with a 9/64-inch Allen wrench. Do not over tighten the screws.
See Figure 5-3.

4. Remove the 2 shipping blocks before running the Hydra.
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Sending in your DT head

Call the Technical Service Department to obtain a return number and to have a
Hydra DT syringe head case sent to you. If you require a loaner DT head, one
can be provided with a weekly charge. Contact the Technical Service department
for more details.

z Note: It is required that you use this case when sending in your head
for service.

1. In order to place the syringe head properly into the case, the handle will have to
be removed. Loosen and remove the socket-head screw with a 5/32-inch Allen
wrench on both sides of the head. Then loosen and remove the upper flathead
screws from the clamping mechanism as shown. The handle should come free
easily. See Figure 5-14.

Figure 5-14: Removing the Hydra DT tip clamping handle

2. The head should be placed into the shipping case with the front glass shield facing
down. See Figure 5-15 for syringe head placement in shipping case.

Figure 5-15: Shipping the Hydra DT syringe head in provided case

5-14
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Checking and Replacing Fuses

The Hydra DT microdispenser has 2 fuses that you might need to replace at some
time.

The power module, located inside the microdispenser behind the power switch and
plug on the back of the microdispenser, contains two 3-amp fuses. If the system does
not turn on when you press the power switch on, you might need to replace one
power-module fuse.

The third user-replaceable fuse, a 4-amp fuse, is on the logic power supply. If the
LED display does not come on when you press the microdispenser’s power switch on,
neither the syringe head nor tray table/stage moves when you press dispenser buttons,
and the green light on the controller board does not blink, then you might need to
replace this fuse.

The following pages contain procedures to check and replace these fuses.

Procedure 5-8: Check and replace the fuses in the power module

If the microdispenser does not turn on when you press the power switch on, follow
this procedure to see, first, whether the power-module fuses are the source of the
problem and, second, to check the fuses and replace them if necessary.

Before you start
Have these items ready to use:
m Two replacement fuses

m Flat-blade screwdriver
m A voltmeter or continuity meter

Checking and replacing the power-module fuses
1. Ensure that the microdispenser is plugged in. If it is, go on to Step 2.

2. Ensure that the Emergency Shutoff Switch is installed. The switch must be
installed for the system to operate. If the switch is installed, go on to Step 3.

3. Ensure that the Emergency Shutoff Switch is turned on. Rotate the red button on
the switch in the clockwise direction, as is shown in the arrows on the button. See
Figure 5-16. If the Emergency Shutoff Switch is turned on, go on to Step 4.

)
EMERGENEY
arop

2] @

Figure 5-16: Emergency Switch
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4. Check the power module fuses as follows:

a. Turn off power to the microdispenser and unplug the power cord from the
surge suppressor.

b. Unplug the power cord from the microdispenser.

5. Insert the edge of the flatblade screwdriver in the slot at the top of the power-
module cover, and gently pry the cover open. See Figure 5-17 for a closeup view
of the power module.

Figure 5-17: Power Module

6. Insert the tip of the screwdriver in the slot at the top of the red fuse box. Gently
pry the box away from the microdispenser. Grasp the box with your fingers and
remove it from the power module. See Figure 5-18.

Figure 5-18: Removing the Fuse Box

7. Use the voltmeter or continuity meter to check whether the fuses are live.

e If the fuses are live, reinsert the fuse box in the power module. Then
contact your equipment provider for assistance in determining the source
of the problem. See page 1-9 for contact information.

e If the fuses are not live, replace them as follows:
8. Lift out the fuses on both sides of the red fuse box.

9. Insert the new fuses.
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10. Reinsert the fuse box in the power module and then close the power module
cover.

11. Plug the power cord into the receptacle on the back of the microdispenser and
then into the surge suppressor.
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Getting the Most Out of Your Hydra DT Microdispenser

Microdispenser

To use your Hydra DT microdispenser effectively, you need to first understand some
of the basics of its operation. A discussion of (1) Aspirate/Dispense modes, (2)
priming syringes, and (3) setting dispense heights is provided here to give you basic
information on the fundamental operations of the Hydra DT microdispenser.

Two Aspirate/Dispense Modes

Different liquid handling applications require different Aspirate/ Dispense modes.
The Hydra DT microdispenser has two Aspirate/Dispense modes:

m Aspirate with Overstroke/Dispense Specific

m Aspirate with Pre Air Gap/Dispense All

Some of the terms used in the Hydra DT EPROM-file display differ from the ones
used in the ControlMate software. Please see the following table.
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Table 6-1: Related Terms in ControlMate Software for Hydra DT & in
Hydra DT EPROM-File Display

ControlMate Term EPROM-File Term
Pre Air Gap Air

Dispense All Empty
Dispense Specific Dispense
Overstroke Prime

The rest of this discussion about the two modes will use the ControlMate terms unless
a distinction must be made between the two types of terms.

When is Aspirate with Overstroke/Dispense Specific the right mode to
use?

The Aspirate with Overstroke/Dispense Specific mode is best used for procedures
that require:

m  Highest accuracy for submicroliter and small-volume dispenses
m Incremental dispensing

m Bulk transfers

Serial dispensing using this mode is one of the most efficient means of transferring
microliter volumes into any number of 96-, 384-, or 1536-well plates. (Note that your
Hydra DT system must be equipped with the X/Y Plate Stage and the accompanying
ControlMate software to dispense into 1536-well plates.)

This mode allows the most accurate method of repetitive dispensing and also allows
dispensing to multiple plates without the need to refill the syringes.

How is Overstroke used in Aspirate with Overstroke/Dispense Specific
mode?

The Aspirate with Overstroke command obtains the desired, programmed volume in
the syringes in this way:

1. Tt first draws in the specified Aspirate volume amount.

2. Then it overshoots that volume by drawing in an additional Overstroke volume.

Options screen under the Add-Ins menu. The Prime volume in the EPROM files
is pre-set to 5% of total syringe volume and is not a user-editable value.

W Note: The Overstroke volume can be reset on the Set Device and Pipettors

3. Next it pushes the plungers back down, dispensing the overshoot volume into the
source vessel, leaving the desired amount in the syringes without excess.



5 MATRIX

luiel thinking.

The actions of the Aspirate with Overstroke command force the syringes against the
lower holding plate to seat them in preparation for dispensing. The syringes have
been “auto-primed” (primed by default) one time. Matrix Technologies recommends
that you follow this default priming with 3 to 5 more manual primes just before the
Dispense operation is performed. See page 6-8 for more information about priming
syringes.

After the Aspirate operation has finished, you use the Dispense command to dispense
the programmed volume into the receiving plate. When you select the Specific option
in the Dispense command, the command empties just the volume that you have set in
your file as the Dispense Volume, rather than the entire contents of the syringe.

How do | program a file to use the Aspirate with Overstroke/ Dispense
Specific mode and then run the file?

The following paragraphs provide a basic description of how to program a file in this
mode and then run the file. For detailed information about creating, changing, and
saving the files you will use to run protocols on the Hydra DT microdispenser, see
Chapter 3 if you are using Manual Operation or Chapter 4 if you are using Automated
Operation.

In Manual Operation:

To program a Hydra DT EPROM file to use the Aspirate with Overstroke/Dispense
Specific* mode, use the following procedure. (*Note: In the EPROM files, the
“Aspirate with Overstroke/ Dispense Specific” mode is actually “Aspirate with
Prime/ Dispense.”)

1. In your chosen Hydra DT file, set the specified Dispense and Aspirate parameters

as follows:
Screen Parameter Value
Dispense Vol Specific incremental (partial) dispense amount required by your
application.
Aspirate Prime* ON
Vol Aspirate volume sufficient to provide as many of your dispense volumes
as the syringes will hold, allowing space in the syringe for the Prime
volume*.
Air 0 (zero)
*Prime volume is pre-set to 5% of the total syringe volume and is not a user-editable value.

2. Set the other file parameters (for example, Table Height and Speed that are
correctly calibrated for your application and labware) in the file.
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To run a Hydra DT EPROM file in the Aspirate with Overstroke/ Dispense Specific

mode:

1. Access the Ready Mode screen for the file.

2. Put an empty reservoir on the tray table/stage and press Empty to empty the
syringes.

Replace the reservoir with the source plate containing the sample.

4. Press Aspr to aspirate the Vol and the Prime volume into the syringes. (Vol
should be large enough to allow you to dispense the Dispense Vol amount into as
many of your receiving microplates as possible while still leaving space in the
syringe for the Prime volume.)

Remove the source plate and place the destination plate on the tray table/stage.

6. Press Dispense to dispense Vol into the destination plate.

7. Continue to remove and replace destination plates and to press Dispense until the
sample volume in the syringes is too low to provide more dispenses.

8. Repeat Step 3 through Step 7 as many times as needed for multiple source and
destination plates.

9. When you are finished dispensing, press Empty to empty any remaining sample

volume back into the source plate or into a waste reservoir.

In Automated Operation:

To program a sequence file to using Aspirate with Overstroke/ Dispense Specific
mode, use the following procedure:

1. In your sequence file, set the specified Aspirate and Dispense parameters as
follows:
Command Parameter Value
Aspirate Overstroke* Option is selected.
Aspirate Aspirate volume sufficient to provide as many of your dispense volumes
volume as the syringes will hold, with just enough space in the syringe for the
Overstroke volume.”
Dispense Specific Option is selected.
Volume Specific incremental (partial) dispense amount required by your
application.
* Overstroke volume is set on the Set Device and Pipettor Options screen under the Add-Ins menu.
If you need to fine-tune the value for your applications, you can reset it there.
2. Set other command parameters in the file as needed.
3. Click the Validate File icon ! in the Toolbar. If any errors are listed, correct

them and then re-validate the file.
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To run a sequence file in the Aspirate with Overstroke/Dispense Specific mode:

1. Access a Hydra DT EPROM file, and check that the Empty (Table) height is set
to a safe height.

2. Put an empty reservoir on the tray table or on the stage in the source nest under
the dispensing head and press Empty to empty the syringes.

3. Replace the reservoir with the source plate containing the sample.

4. Access the sequence file in the ControlMate software.

5. If the system is a Hydra DT with X/Y Plate Stage system, place the first
destination plate in the destination nest.

6. Click the Run "2 icon on the Toolbar.

7. After the Aspirate with Overstroke command has executed: On the Hydra DT
base-unit system or Hydra DT with Wash Pump Module, remove the source plate
and place the destination plate on the tray table.

8. Continue to remove and replace destination plates as your sequence file requires.

9. Repeat Step 4 through Step 8 as many times as needed for multiple source and
destination plates.

10. When dispensing is completed, press Empty on the Hydra DT microdispenser to
empty any remaining sample volume back into the source plate or into a waste
IeServoir.

When is Aspirate with Pre Air Gap/Dispense All the right mode to use?

The Aspirate with Pre Air Gap/Dispense All mode is best used for procedures in
which:

m  Source plates have minimal sample volumes.

m Residual sample cannot be returned to the source plate after the transfer.
m  Multiple samples are pooled.

m Individual samples of microliter volumes are transferred.

Use of this mode is necessary when there is insufficient sample to allow for the
overshoot volume that occurs with the Aspirate with Overstroke command. Sample
volumes of as little as 1.0uL have been transferred using the Aspirate with Pre Air
Gap/Dispense All mode.

Aspirate with Pre Air Gap/Dispense All mode is also preferred if the user does not
want to draw excess sample into the syringes only to return the remainder of the
sample to the sample plate after the transfer.

When pooling multiple samples, you use the Aspirate command to draw first an air
gap (see Table 6-2 on page 6-9 for recommended air-gap volumes) and then the

Getting the Most Out of Your Hydra DT Microdispenser
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samples into the syringes. Then you use the Dispense All command to deliver the
pooled samples and the air gap into the final receiving plate.

Microliter volumes of individual samples can also be transferred using the Aspirate
with Pre Air Gap/Dispense All mode. Here, as with pooling, you first draw an air gap
(see page 6-9 for recommended air-gap volumes) into the syringes using Aspirate,
and then you use Aspirate to draw the single volumes to be transferred into the
syringes. Finally, you use the Dispense All command to deliver the entire contents of
the syringes, including the sample volumes and the air gap, into the receiving plate.

Why are air gaps used in the Aspirate with Pre Air Gap/Dispense All
mode?

Aspirating an air gap into the syringes at the beginning of a procedure in the Aspirate
with Pre Air Gap/Dispense All mode increases accuracy in dispensing individual
small volumes and helps to force all of the sample volume out of the syringes during
the dispense. For details about using an air gap, see “Priming Syringes in Aspirate
with Pre Air Gap/Dispense All Mode” on page 6-9.

How do | program a file to use the Aspirate with Pre Air Gap/Dispense
All mode and then run the file?

The following paragraphs provide a basic description of how to program a file in this
mode and then run the file. For detailed information about creating, changing, and
saving the files you will use to run protocols on the Hydra DT microdispenser, see
Chapter 3 if you are using Manual Operation or Chapter 4 if you are using Automated
Operation.

In Manual Operation:

To program a Hydra DT EPROM file to use the Aspirate with Pre Air Gap/Dispense
All mode, use the following procedure:

1. In your chosen Hydra DT file, set the specified parameters as follows:

2. Set the other file parameters (for example, Table Height and Speed that are
correctly calibrated for your application and labware) in the file.

Screen Parameter Value
Aspirate Prime OFF
Vol Total sample volume
Air Recommended air gap for your system (See Table 6-2 on page 6-9.)

To run a Hydra DT EPROM file in the Aspirate with Pre Air Gap/Dispense All mode:
1. Access the Ready Mode screen for the file.

2. Put an empty reservoir on the tray table/stage and press Empty to empty the
syringes.
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3. Replace the reservoir with the source plate containing the sample.
4. Press Aspr to aspirate Vol and Air into the syringes.

5. Remove the source plate and place the destination plate on the tray table/stage in
the nest under the dispensing head.

6. Press Empty to dispense the total syringe contents into the destination plate.

In Automated Operation:

To program a sequence file to use the Aspirate with Pre Air Gap/Dispense All mode,
use the following procedure:

1. In your sequence file, set the specified Dispense and Aspirate parameters as

follows:

Command Parameter Value

Dispense All (Option is selected.)

Aspirate Pre air gap (Option is selected.)
Pre air gap Recommended air-gap volume for syringe size (See Table 6-2 on page
volume 6-9.)
Aspirate Total sample volume, or as much of sample as will fit in syringe with air
volume gap

2. Set other command parameters in the file as needed. If your system is a Hydra DT
with X/Y Plate Stage system, include Move commands that move the source and
destination nests under the dispensing head.

3. Click the Validate File ' [Fl icon in the Toolbar. If any errors are listed, correct
them and then re-validate the file.

To run a sequence file in the Aspirate with Pre Air Gap/Dispense All mode:

1. Access a Hydra DT EPROM file, and check that the Empty (Table) height is set
to a safe height.

2. Put an empty reservoir on the tray table/stage in the nest under the dispensing
head and press Empty to empty the syringes.

3. Replace the reservoir with the source plate containing the sample.

4. Access the sequence file in the ControlMate software.

5. On the Hydra DT with X/Y Plate Stage, place the destination plate in the
destination nest.

6. Click the Run "2 icon on the Toolbar.

7. On the Hydra DT base-unit system or Hydra DT with Wash Pump Module:
Follow software-prompt instructions to remove the source plate and insert the
destination plate.

Getting the Most Out of Your Hydra DT Microdispenser
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Priming Syringes

After the Hydra syringes have been filled with the solution to be dispensed, the
syringes must be “primed” to ensure accuracy and precision of the operation. To
explain the reasoning behind the need to prime the syringes, a short discussion of the
Hydra DT design is presented here. There is a slight amount of movement (referred to
as “lash”) of the glass syringes that is designed into the Hydra DT micro-dispenser
such that at the beginning of a Dispense or Aspirate step, the syringe barrels move up
or down together with the plungers until they contact the upper or lower holding
plate. (Holding plates pro-vide vertical and horizontal positioning of the syringes
within the head unit of the microdispenser.) During this short interval of “lash
movement” the plunger does not move inside the barrel of the syringe, so no sample
is dispensed or aspirated. After the syringe barrels have been seated against the
holding plate, the plunger begins to move within the syringe and aspirating or
dispensing of sample begins.

The way to account for the effects of lash is to “prime” the syringes. The following
two subsections tell you how to prime the syringes, first for the Aspirate with
Overstroke/Dispense Specific mode and then for the Aspirate with Pre Air
Gap/Dispense All mode.

Priming Syringes in Aspirate with Overstroke/Dispense Specific Mode

Aspirate with Overstroke/Dispense Specific mode uses the Aspirate with Overstroke
option to fill the syringes for a dispense operation. The Overstroke action provides
initial priming. The microdispenser draws the desired amount of liquid into the
syringes, overshoots this volume by the specified Overstroke volume (typically an
additional 5-50uL), and then dispenses the extra volume back into the reagent
reservoir, leaving the desired volume in the syringes. (The necessary amount of
Overstroke volume depends on syringe size. In ControlMate software, it is set by the
user on the Set Device and Pipettors Option screen under the Add-Ins menu. In the
Hydra DT EPROM files, the (Prime) value is set to 5% of total syringe volume and is
not user-editable.) This default priming forces the syringes against the lower holding
plate to seat them in preparation for dispensing. Matrix Technologies recommends
that immediately before the dispense is to be performed you supplement the default
priming by dispensing the desired volume back into the sample reservoir 3—5 times.
At this point the syringes will be seated firmly against the bottom holding plate so
that any further downward movement of the plungers will result in the precise volume
of fluid being dispensed from the syringes. The dispense operation should be carried
out immediately after the last priming.
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Priming Syringes in Aspirate with Pre Air Gap/Dispense All Mode

Aspirate with Pre Air Gap/Dispense All mode requires a method to account for lash
other than the one used in Aspirate with Overstroke/ Dispense Specific mode. In an
aspirate-transfer, the Aspirate command (with no Overstroke) is used to draw sample
into the syringes. When an Aspirate command is executed, the plungers are
immediately raised, resulting in: first, the joint upward movement of the syringes and
plungers; second, seating of the syringes against the upper holding plate of the head;
and finally, aspirating of liquid into the syringe needles. The result is less than the
desired amount drawn into the syringes. To prevent this error, program your file so
that an initial air gap (see Table 6-2, below) is drawn into the syringes before the
Aspirate command is used to draw sample into the syringes. Here are recommended
air gap volumes:

Table 6-2: Recommended Air Gap Volumes

Syringe Size Recommended Air Gap Volume
100pL, 290uL 10uL

580uL 50uL

imL 100uL

Drawing air into the syringes will seat them firmly against the top holding plate in
preparation for aspirating.

Setting Dispense Heights

Dispense heights are set on the Hydra DT microdispenser by raising and lowering the
tray table/stage. Different dispense heights are required for different types of dispense
operations. If you are dispensing very small volumes onto dry plates, for example,
you will set the height differently than you would for a larger-volume dispense into a
plate that contained buffer.

The following figures illustrate various dispense scenarios, with dispenses into wet
and dry plates and with differences in dispense volumes. The information presented
here should help you determine the optimum dispense height for your applications.

Note: For many operations you need to set the tray table/stage height to a near-
bottom-of-the-well position. For instructions on how to do this, see “Set the tray
table/stage height” on page 3-7

Getting the Most Out of Your Hydra DT Microdispenser
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Dispensing Into Wet Plates

Figure 7-1 through Figure 7-3 illustrate dispenses into wet plates. They show three
dispenses with the needle tips at slightly different heights. (They also illustrate that
dispense height can vary considerably more when dispensing into a wet plate than

onto a dry plate and still result in a successful dispense.)

Table 6-3: Dispensing Into Wet Plates

Figure 6-1: Dispense into wet plate, with tip just touching solution

Figure 7-1 shows the tip just touching the solution already in the well. This
dispense height will allow effective delivery of sample to the well while
minimizing the exposure of the needle tip to the solution in the well.

Figure 6-2: Dispense into wet plate, with tip submerged in solution
Figure 7-2 shows the tip submerged in solution. The sample will be delivered
successfully into the solution in the well.

L
S
U

Figure 6-3: Dispense into wet plate, with tip above solution

Figure 7-3 shows the needle tip above the solution, with the drop on the tip not
touching the solution. No sample is delivered during this dispense. The drop
will remain on the tip.
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Dispensing Onto Dry Plates
Figure 7-4 through Figure 7-7 illustrate dispenses onto dry plates.

Table 6-4: Dispensing Onto Dry Plates

Figure 6-4: 10uL dispense onto dry plate—drop fills gap between tip and well
bottom. Touch-off occurs.

Figure 7-4 shows a 10pL dispense onto a dry plate. For this type of dispense,
you set the tips so that they are close to but not touching the bottom of the well
— a “near bottom” position. The drop on the tip of the tip fills the gap between
the tip and the bottom of the well. When the tip is retracted, the drop will “touch
off” onto the well bottom. The dispense is successful.

Figure 6-5: 1uL dispense onto dry plate—drop unable to bridge gap between
needle tip and well bottom. Drop remains attached to tip. Figure 7-5 shows a
needle tip at the same dispense height as the one in Figure 7-4. For this
dispense, however, the dispense amount is very small— 1pL. As illustrated,
the drop is not large enough to fill the gap between the tip and the bottom of
the well, and the drop remains attached to the tip, so there is no “touch off.”
The dispense is unsuccessful. Solution: Reset the Dispense height parameter
so the tips are touching the well bottom during the dispense.

Figure 6-6: 1uL dispense onto dry plate—tip touches plate bottom and drop
dispenses around tip onto well bottom.

Figure 7-6 shows the tip at a dispense height that just touches the tip to the
bottom of the well. To set this height, move the tray table/stage up so that you
can feel that some of the needle tips are just touching the well bottom, and
then move the tray table/stage up one or two more clicks. You can check
whether tips are touching the plate by trying to lift the front of the plate with
your forefinger. If the plate does not lift, the tips are touching the plate. This
figure shows the same 1pL dispense amount as in Figure 7-5. This time, the
dispense is successful because the drop squeezes out from the tip onto the
bottom of the well and touches off as the tray table/stage drops down.
Because the amount of dispense is so small (<3uL), pressure does not build
back up into the syringe even though the needle tip is pressing down onto the
plate.

Figure 6-7: 10puL dispense onto dry plate; tip touches plate bottom. Drop
dispenses around tip onto well bottom but cannot dispense quickly enough to
prevent pressure buildup.

Figure 7-7 shows the tip in the same position as in Figure 7-6, with the tip
touching the bottom of the well. In this instance the dispense amount is 10pL,
and the needle cannot dispense the amount quickly enough to keep the
pressure from building back up into the syringe. This pressure buildup is likely
to damage the syringe. Solution: Reset the Dispense height parameter so the
needle tips are not touching the well bottom of the plate.

Q) = [=Q)=
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Caution: In general, do not allow the tips to contact the bottom of any
plate, tube, reservoir, tray, or wash basin. The only time the tips need to touch
the bottom of the plate is when they are dispensing volumes of 3pL or less onto a
dry plate (as shown in Figure 7-6). For dispense volumes greater than 3pL, the
size of the droplet formed on the tip will be large enough to bridge the gap
between the tip and the bottom of the plate. In such cases, set the dispense
height at two to three clicks back from touching the plate. If the tips touch the
plate during a dispense with volume greater than 3uL, backpressure will build up
in the syringes (as shown in Figure 7-7), because the sample cannot exit the tips
as fast as the syringe plunger is pushing the sample out. That backpressure can
damage the syringes. If a syringe is damaged during operation, turn off
power to the unit immediately by pressing the Emergency Shutoff Switch.

For More Detailed Information About Hydra Microdispenser Operation

For more detailed information about the microdispenser’s operation, see the Hydra
Technical Data page on the Matrix Technologies website at
http://www.matrixtechcorp.com/.

Dispensing Onto the Sidewalls of Wells in CyclePlate-ET Plates

To dispense droplets of different solutions into a microplate well without touching the
needle tips or the solution to be dispensed to the current contents of the wells, set up
the instrument to dispense onto the sidewalls rather than into the center of the well.
The following procedure describes how to dispense solutions onto the sidewalls of the
96 wells in a CyclePlate-96ET without touching any other solution currently found in
the wells (you can use the same procedure with CyclePlate-192 and -384
microplates).

operated plate positioner, the Hydra-96 Plate Positioner for CyclePlate-384 and
-192ET, Matrix Technologies Catalog No.1029-41-0.

i T Note: In Manual Operation, this procedure requires use of the split-well manually
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In Manual Operation:

1.

Place a CyclePlate-96 ET PCR plate in the split-well Hydra-96 Plate Positioner
for CyclePlate-384 and —192ET (manually operated plate positioner).

Transfer the assembly onto the tray table of the Hydra DT 96 micro-dispenser.

Set the Dispense (Table) height so the needle tips are just touching the sides of the
conical wells above the expected level of solution when the sample is transferred.

Set all other file parameters as needed.

5. Remove the microplate and replace it with an empty reservoir identical to that

10.

11

13.

containing your sample solution. Set the Aspirate Volume, Aspirate (Table)
height, and Dispense (Table) height parameters accordingly.

Remove the empty reservoir and replace it with the source reservoir containing
your sample(s).

Fill the syringes with the sample solution and then remove the reservoir.

Remove the source reservoir and position your first destination CyclePlate-96 ET

microplate in the manual plate positioner. Place the positioner with the CyclePlate
on the tray table.

Dispense the solution into the microplate. The droplet should just touch off onto
the side of the well.

Repeat Step 8 and Step 9 for as many microplates as you want to fill with the
sample solution.

. Change the D.A.R.T's as needed between multiple samples.
12.

Repeat steps 1 — 11 for each new solution sample plate, advancing the split-well
positioner to the next position each time that you change solutions. You can
perform this procedure for four separate sample or reagent solutions so that each
one is placed on a different side of the well.

Centrifuge the destination plate after the final solution addition to pool all the
reagents in the bottoms of the wells.

Figure 6-8 and Figure 6-9 on page 6-14 illustrate use of the Hydra-96 Plate Positioner
for CyclePlate-384 and -192 (a manually operated, split-well plate positioner, Matrix
Technologies Catalog No. 1029-41-0) to dispense solutions onto the sidewalls of
Cycle-Plate wells.

Getting the Most Out of Your Hydra DT Microdispenser
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In Automated Operation:

On the Hydra DT with X/Y Plate Stage system, use tip/well offset settings on the
Move to Position command screen to position the depth and X-Y placement of the
tips in relation to the centers of the wells.

On the Hydra DT base-unit system, use the manual plate positioners as described
previously.

Table 6-5: Dispensing Solutions Onto Sidewalls of CyclePlate
Microplate Wells

Figure 6-8: Needle Position for PCR Plate on Tray Table

When a CyclePlate-96ET plate is used on the Hydra DT microdispenser tray
table, the needle tip will dispense into the center of the well, as shown in
Figure 7-8.

Use of the Hydra-96 Plate Positioner for CyclePlate-384 and -192 plates
allows you to dispense solution onto the side of a CyclePlate well rather than
into the center. This technique guards against cross-contamination of samples
by allowing solution to be added to a well without touching any sample
currently in the plate. Figure 7-9 shows the needle position.

I Figure 6-9: Needle Position for PCR Plate on Plate Positioner
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Using the Microdispenser in Cell Culture Applications

Some laboratories have reported success in using the Hydra DT micro-dispenser to
transfer cells and cell culture media. To create the required sterile environment, take
the following steps:

1. Place the Hydra DT microdispenser in a laminar flow tissue culture hood. Best
results will be achieved if the unit is left in the hood. An initial wipedown of the
Hydra DT microdispenser with ethanol and paper towels is recommended. You
can wipe down the instrument periodically whenever you similarly clean the
inside of the culture hood.

Note: The Hydra DT microdispenser can be kept in a hood with the UV
(ultraviolet) light on for extended periods. However, the plastic components on
the outside of the Hydra DT case (that is, the switches, the cover over the
display, and the data-port connectors) might be damaged after prolonged UV
exposure. If those parts become corroded, you will need to replace them.

A Caution: Do NOT pass syringe needles through the flame of a Bunsen burner.
2

. You can sterilize the syringes initially if you remove them from the Hydra DT
microdispenser and soak them in a 100% ethanol solution. If you do this, you
must ensure that each syringe remains paired with its original plunger tip
throughout the lifespan of the plunger tip. (See Table 5-3 on page 5-4 for PTFE
tip replacement guidelines.)

3. A less laborious approach would be simply to fill the syringes with a 100%
ethanol solution, leave the reservoir with the ethanol solution on the tray
table/stage, and leave the tray table/stage in the up position so that the needle tips
are submerged in the ethanol solution. To leave the syringes soaking in the
ethanol solution: Place the reservoir containing the ethanol solution on the tray
table/stage. In an EPROM file, set Vol to full volume. Before you press the Aspr
button, position yourself so you can easily reach the power switch on the back of
the microdispenser. Press Aspr, and when the syringes are full and the tray
table/stage is up so that the needle tips are submerged by at least 2cm, press the
power switch to OFF. Now both the needle tips and the interior of the syringe
barrels will be bathed in the ethanol solution during the storage interval. After the
syringes are soaked, the ethanol should be discarded and the syringes rinsed with
3 wash cycles of sterile dH,0.

Getting the Most Out of Your Hydra DT Microdispenser 6-15



6-16

MATRIX

fluid thinking.

4. When the Hydra DT microdispenser is used to transfer culture media or media
containing suspended cells, keep in mind that ethanol may lyse cells. To minimize
the chances of cell lysis inside the syringes: Wash the syringes between uses of
different media or reagents with 3 wash cycles of ethanol and as many as 9 wash
cycles of autoclaved dH,O. Use fresh sterile water for every 3 wash cycles.

5. To further ensure that the syringes are clean, you can wash the syringes with a
nonionic detergent solution such as Coulter® Clenz (Beckman Coulter cat.#s
8546929-31). If you use a detergent wash, ensure that all residual detergent is

removed by washing the syringes with multiple water washes after the detergent
wash.
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Creating Dot Blots and Membrane Arrays With the
Vacuum Manifold

The Hydra DT 96 base-unit system and Hydra DT 384 base-unit system
microdispensers can be used to prepare dot blots and membrane arrays of various
densities. To prepare a simple dot blot, put several pieces (approximately 5) of filter
paper on the tray table of the microdispenser and lay a membrane (dry or pre-wetted)
on top of the paper. You can also place the filter paper and membrane in a Multi-
Blot® tray (Catalog Nos. 1039-50-0 [standard] and 1039-51-0 [sterile]) for this
purpose if you wish. Set the dispense height so that the needles will press the
membrane down onto the filter paper but will not penetrate it when sample solutions
are dispensed.

For creating arrays of densities greater than 96 samples on the membrane, with the
samples placed within the spacing of a standard microplate, Matrix Technologies
recommends using our vacuum manifold (Catalog No. 1029-42-0) because of the
following advantages:

m The membrane is anchored firmly by the vacuum, so it will not shift during
multiple spottings.

m The vacuum manifold ensures a uniform vacuum across the membrane and helps
limit diffusion of the sample as it is being applied to the membrane, giving a more
concentrated sample and a smaller spot size that allows higher density arrays.

To use the vacuum manifold, follow these steps:

1. Place the manifold on the Hydra DT microdispenser tray table and connect it to a
vacuum source.

2. Place a dry or pre-wetted membrane on the manifold. Ensure that the membrane
covers the top of the manifold completely but is not larger than the top of the
manifold.

3. Adjust the Dispense (Table) height parameter so that the needles hover above the
membrane by approximately 1mm. This height setting will allow effective touch
off during dispense while avoiding penetration of the membrane by the needle
tips.

4. Run the Hydra DT microdispenser dispense protocol to spot solutions containing
target molecules onto the membrane.

Getting the Most Out of Your Hydra DT Microdispenser 6-17
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With the Hydra DT 96 base-unit system you can use the standard plate positioner (see
“Using the Manually Operated Plate Positioners for the Hydra DT 96
Microdispenser” on page 6-19) with the vacuum manifold to create membrane arrays
with a density of 384 samples. Figure 6-10 shows the two manually operated plate
positioners and the vacuum manifold.

Figure 6-10: Manually Operated Plate Positioners and Vacuum Manifold

Note: With the Hydra DT with X/Y Plate Stage system, you can also use the
manifold to create membrane arrays with densities of 1536 to 9600 samples.

For more information on the vacuum manifold and other accessories for the
Hydra DT microdispenser, including the manual plate positioners, and on MultiBlot
trays, see the Matrix Technologies website at http://www.matrixtechcorp.com/.
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Using the Wash Operation as a Mix Operation

In Manual Operation mode, you can use the Wash operation to mix multiple solutions
added sequentially to the wells of a microplate. (In Automated Operation mode, use
the Mix command. See page 4-65 for information about the Mix command. )

Dispense each of the solutions you will mix into the same micro-plate, one after the
other. Set the Wash (Table) height close to the bottom of the plate and the wash
volume (Wash Vol) to draw up less than the total volume of the combined solutions
into the syringes. Push the Wash button. All the combined solutions (less a small
amount) will be aspirated and then emptied back into the microplate.

When you set up your file parameters for this operation, the Wash (Table) height
parameter must be set so the needle tips are submerged below the top of the combined
solutions and so that no air is drawn into the syringes when the wash volume is drawn
up from the microplate.

Using the Manually Operated Plate Positioners DT

To accommodate the well spacing of different 96-well and 384-well microplates,
Matrix Technologies offers two manually operated plate positioners for the Hydra DT
96 microdispenser for dispensing into 384-well plates:

m  Hydra-96 Plate Positioner for Standard 384 Well Plates (Catalog #1029-41-5)
m  Hydra-96 Plate Positioner for CyclePlate®-384 and -192 (Catalog #1029-41-0)
Figure 6-10 on page 6-18 shows the manually operated plate positioners.

The positioner for standard 384-well plates is based on the 4.5mm center-to-center
spacing found in 384-well plates that adhere to the Society for Biomolecular
Screening (SBS) standards for size and shape. When the positioner is used to create
membrane arrays of 384 samples, the spots on the membrane will also have a spacing
of 4.5mm.
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The “split-well” positioner is needed when using the Hydra DT micro-dispenser to
transfer liquid to and from CyclePlate®-192ET and 384ET microplates. You can also
use it with the CyclePlate-96, -192, or -384 ET plates to dispense solutions onto the
sidewalls of the wells rather than into the centers of the wells. See page 6-21 for
information about dispensing onto sidewalls of wells. This positioner cannot be used
with 384-well plates that adhere to the SBS standards because the positioner does not
align a plate according to the 4.5mm spacing grid of the standard plates.

See Figure 6-11 for illustrations of microplate well-center-to-well center spacing.

<—4 5mm—>|<—4 5mm+¢4 5mm>»

Figure 6-11: Well-Center-to-Well-Center Spacing for SBS Microplates and Matrix Technologies’
CyclePlate-192 and -384 ET Microplates
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Using the Hydra-96 Plate Positioner for Standard 384-Well Plates

1. Place the positioner on the Hydra DT 96 tray table.

2. Load the plate onto the positioner. (The CyclePlate-384DW (“discrete well,” thin
wall) microplate requires that Matrix Technologies’ removable adapter tray
(Matrix Technologies’ Catalog No. 1029-41-2) be placed on the positioner first to
secure the plate properly.)

3. Turn the thumbwheel on the front of the positioner to move it sequentially to each
of four positions for dispensing or aspirating liquid to or from each of the four
sets of 96 wells in the 384-well plate.

Using the Hydra-96 Plate Positioner for CyclePlate-384 and 192
Plates

The split-well positioner is used in much the same way as the standard positioner.
You may find it more efficient to load the CyclePlate microplates onto the positioner
with the positioner removed from the Hydra tray table.

Dispensing Onto the Sidewalls of Wells in CyclePlate-ET Plates
With a Plate Positioner

See page 6-21 for information on using the Hydra-96 Plate Positioner for CyclePlate-
384 and -192 (Matrix Technologies’ split-well, manually operated plate positioner) to
dispense solutions onto the sidewalls of wells in CyclePlate-96, -192, or -384ET
microplates.

Creating Membrane Arrays With the Vacuum Manifold and a Plate
Positioner

You can use the Hydra-96 Plate Positioner for Standard 384 Well Plates with the
vacuum manifold to create membrane arrays of up to 384 samples. See “Creating Dot
Blots and Membrane Arrays With the Vacuum Manifold” on page 6-17 for more
information about this use of the manifold and plate positioner for creating 384-
sample membrane arrays.
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Using the Hydra DT 96 With Wide Bore D.A.R.T.s With
Resin Suspensions

The Hydra DT 96 system with R/B syringes was designed to allow multichannel
dispensing of insoluble resins and beads into 96-well microplates or blocks. The
Wide Bore D.A R.T.s design for this Hydra DT model incorporates a larger-bore tip
than those of the standard D.A.R.T.s types. These design features facilitate the
passage of the suspensions, preventing the solid particles from collecting and
clogging the tips. When presented as homogenous suspensions, beads of up to 300um
in diameter (dry) have been drawn into the Wide Bore D.A.R.T.s of the Hydra DT 96
system and dispensed uniformly into 96-well receiving plates and blocks.

General Guidelines for Using the Microdispenser With Resin
Suspensions

Keep these two points in mind as you use the Hydra DT 96 system with Wide Bore
D.A.R.T.s with resin suspensions:

m  The most important factor in the accuracy of delivery is that the suspension be
maintained in a homogeneous state so that each syringe in the array and each
dispense will contain the same concentration of the bead or resin.

m  Each resin has its own characteristic behavior in suspension. Some resins have
been dispensed in concentrations of up to 5%, while others can only be transferred
when in concentrations of 2% or less. The principal difficulty for using some
resins at the higher concentrations is that the particles begin to clump and
aggregate, which can clog the syringes. Each new resin should be thoroughly
tested by gradually increasing the percent concentration to verify the highest
concentration that will allow trouble-free dispensing with the Hydra DT 96
system with Wide Bore D.A.R.Ts.

with the microdispenser, contact your equipment provider.
See page 1-9 for contact information.

z Note: If you have questions about types of beads and resins that can be used
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Examples of Types of Materials Used in Resin Suspensions on the
Hydra DT 96 System With Wide Bore D.A.R.T.s

Examples of the types of solid materials that have been successfully used with the
Hydra DT 96 system with R/B syringes and descriptions of its use follow.

Table 6-6: Examples of Materials Dispensed With the Hydra DT 96
System With Wide Bore D.A.R.T.s

. . Bead Diameter Concentration
Suspension Material Before Swelling Tested
Sephadex® G-50 =<160um 2%

Tentagel S NH2 (in 300um 2%
DCM/DMF)

Yttrium Silicate (for | 2—5um 20mg/mL
SPA)

PVT (for SPA) Sum 20mg/mL
CPG 500 angstrom 0.25% (w/v)

m  Solid supports for chemistry—The solid supports used in chemical syntheses
can be transferred using the Hydra DT 96 system with Wide Bore D.A.R.T.s
when they are prepared as an isobuoyant mixture. Typically, the amount of resin
needed to give a 2% (w/v) solution is weighed out and mixed with the appropriate
volume of 1:1 DCM/DMF (dichloromethane/dimethylformamide). Small volumes
(ImL — 5mL) of DCM or DMF are added incrementally to cause the resin to rise
or settle respectively within the solvent mix. Eventually the solvent mix is
adjusted so that the resin neither rises nor settles. It is isobuoyant and is said to
“float.” The suspension can then be transferred into a receiving plate or block.
Rink resins, Wang resins, Tentagels, ArgoPore® and ArgoGel® (Argonaut
Technologies), SPA (scintillation proximity assay, Amersham Pharmacia
BioTech) beads, and others have been successfully transferred using this method
with the Hydra DT 96 system with Wide Bore D.A.R.T's.

m SPA beads—For this application, SPA (scintillation proximity assay, Amersham
Pharmacia BioTech) beads are suspended in an aqueous solution. They have a
tendency to settle. This settling could present a problem if the beads were large or
tended to form aggregates. But SPA beads are generally sized on the order of Sum
and remain in a uniform suspension long enough to be drawn into the syringes of
the Hydra DT 96 system with Wide Bore D.A.R.T.s and subsequently dispensed.
When SPA beads of yttrium silicate were tested in Matrix Technologies’
laboratories, it was found that even if the beads were allowed to settle within the
syringe barrels, the Hydra DT 96 system with Wide Bore D.A.R.T.s was still able
to dispense them with uniform results across the syringe array.

Getting the Most Out of Your Hydra DT Microdispenser 6-23
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m  Sephadex beads—Sephadex (Amersham Pharmacia Biotech) beads have been

used in applications in high-throughput laboratories using 96-well filtration
blocks to purify cycle-sequencing reaction products prior to loading onto the gel
of an automated sequencer. (For more information about this application, see the
article “Reduced Volume AmpliTag DNA Polymerase FS Cycle Sequencing
Reactions in the Robbins CyclePlate® 384" on the Hydra Technical Data page on
the Matrix Technologies website at http://www.matrixtechcorp.com/). The Hydra
DT 96 system with Wide Bore D.A.R.T.s is used to transfer the Sephadex slurry
into the filtration plates. Despite the fact that the suspension settles quickly within
the syringes, Sephadex G-50 beads of less than 160pm diameter can be drawn
into the syringes uniformly and dispensed even after the beads have settled.

CPG beads—CPG (controlled pore glass) beads have been used as the solid
support in protocols designed for the MerMade DNA oligonucleotide synthesizer
(available from BioAutomation). The diameter of these beads averages
approximately 500 angstrom and does not clog the syringes despite the beads’
near-immediate settling within the syringe barrel.
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In general, do not use the microdispenser to dispense viscous solutions. The
microdispenser is designed primarily to dispense clear, aqueous solutions of low

viscosity.

Hydra DT microdispensers are available with syringe sizes ranging from 0.5uL-
100uL and 5uL-300uL. Matrix Technologies studied the dispensing limits for several
Hydra microdispenser models. Test results indicated that the larger bore syringe-and-
needle combinations are capable of filling and dispensing the more viscous solutions.

Data for the methylcellulose solutions showed that both the Hydra DT 96 and the

Hydra DT 384 with 100uL syringes should be used with methylcellulose solutions of

less than 26 cps viscosity.

Table 6-7: Pass/Fail Test Results for Filling Syringes to Full Volume
With Solutions of Varying Percent Glycerol Composition

Percent Glycerol

30 50 60 75 80 90 100
Hydra DT 384 100pL + + -
Hydra DT 96 100pL + + + -
Hydra DT 96 290pL + + + + + -
Table 6-8: Pass/Fail Test Results for Filling Syringes to Full Volume
With Methylcellulose Solutions of Varying Viscosity
Viscosity (cps)
25 50 100 250 400 1000 | 1500

Hydra DT 384 100uL

+

Hydra DT 96 100pL

+

Hydra DT 96 290puL

+

+

+

For more information about these tests, refer to the article “Dispensing Viscous
Fluids with the Hydra Microdispenser” on the Hydra Technical Data page on the
Matrix Technologies website at http:// www.matrixtechcorp.com/.

If you have any questions about using the microdispenser to dispense solutions with
some limited viscosity, contact your equipment provider. See page 1-9 for contact

information.

Getting the Most Out of Your Hydra DT Microdispenser
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Ensuring Compatibility of Chemicals Used With the
Hydra DT Microdispenser

6-26

To protect your microdispenser from damage and to ensure the integrity of your
results, you need to know which chemicals (acids, bases, organics, etc.) can be safely
used with the microdispenser and how to use them.

The basic guideline for the use of corrosive or oxidizing agents with the
microdispenser is not to allow such agents (chlorine bleach, strong acid, etc.) to be in
continuous contact with the microdispenser. Such agents can be used routinely with
the Hydra DT microdispenser but may damage the case and the tray table/stage if left
in contact with the instrument for extended periods of time. If you need to use these
reagents in a protocol, ensure that you clean the microdispenser of any residual
corrosive agent as soon as you finish the procedure. If you need to use any strong
oxidizing or corrosive agent other than those listed in Table 7-9, contact your
equipment provider. See page 1-9 for contact information. They will give you
guidance on how to use these agents in such a way as to protect the microdispenser
and to ensure the integrity of your samples.

Table 7-9 lists chemical reagents that have been used routinely in the Hydra DT
microdispensers.

Table 6-9: Chemical Reagents Used Routinely With Hydra DT Systems

Acetic acid Diisopropylamine Methanol Trifluoroacetic Acid
Acetone Dimethylacetamide Methylene Chloride Trimethyl Orthoformate
Acetonitrile Dimethyl Formamide Methylene Chloride/TFA, 1:1 | Xylenes

Ammonia 27-30% | Dimethyl Sulfoxide Pyridine Toluene

Chloroform Ethanol Triethylamine
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7: Troubleshooting and Tips

Troubleshooting Topics

Scan the following table to see if your question is listed.

Table 7-1: Troubleshooting Topics

If the problemis ... See page...
1. The system doesn’t turn on when | press the power switch to ON. 7-2
2. The microdispenser is behaving erratically; for example, the system shuts off suddenly or | 7-2
recycles to the beginning of a file.

3. Nothing happens when | press the Dispense button. The power to the system is on and 7-3
the LED display is on.

4. One of the microdispenser’s motors isn’t working properly. 7-3

5. The tray table doesn’t move when | press the microdispenser buttons. | hear a grinding 7-3
noise.

6. When | place a plate on the tray table, the needles don't line up properly in the wells. 7-3

7. The syringe barrels are breaking frequently. 7-4

8. When | use the microdispenser to transfer small volumes, the syringes dispense uneven | 7-4
amounts. I've been using the Aspirate with Overstroke/Dispense Specific mode to fill the
syringes with the solution to be transferred.

9. The seal on the PTFE tips appears to be defective. | can see liquid creeping up inside the | 7-5
barrel above the tips.

10. One or more syringes are not dispensing properly. 7-5

11. When the microdispenser is doing a dry-plate dispense, some of the wells aren’t 7-5

receiving any sample.

12. How do | prevent contamination between sample preparations? 7-5

13. I need to replace some syringes 7-5

Troubleshooting and Tips
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1. The system doesn’t turn on when I press the power switch to ON.

a. Ensure that the microdispenser is plugged in.

b. Ensure that the Emergency Shutoff Switch is installed. The switch must be
installed for the system to operate.

c. Ensure that the Emergency Shutoff Switch is turned on. Rotate the red button
on the switch in the clockwise direction, as is shown in the arrows on the
button.

See Figure 7-1.

6
EMERGENCY
SToP

@ @

Figure 7-1: Emergency Shutoff Switch

2. The microdispenser is behaving erratically. The following have occurred
recently:

e System shuts off suddenly.

e The display on the front of the microdispenser lights up and numbers in the
display change when microdispenser buttons are pressed, but the syringe head
and the tray table do not move.

The problems are most likely caused by electrical interference. Take the following
steps:

a. Ensure that the microdispenser is plugged into a surge suppressor.

b. Check to see if there are other electrical appliances on the same line with the
microdispenser. If there are, they could be causing the disturbance. Test this
theory by removing the appliances from the line and then testing the
microdispenser operation.
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If the preceding steps do not fix the problem, then problems with either the
printed circuit board (PCB) or the power supply are possible. Do not attempt to
fix a PCB or power supply problem; contact your equipment provider. See page
1-9 for contact information. Be sure to tell them all of the “symptoms” that your
microdispenser is displaying.

. Nothing happens when I press the Dispense button [in Manual Operation].

The power to the system is on and the display is on.

You might not be in the right place in the file you are using. To run a procedure,
you must be at the ready-mode screen. Press Page until you see the ready-mode
screen.

. One of the microdispenser’s motors isn’t working properly.

If either or both of the microdispenser motors (the syringe motor is the top motor;
the tray table/stage motor is the bottom motor) isn’t working properly, a printed-
circuit board (PCB) problem or power supply problem is possible. Do not attempt
to fix a PCB or power supply problem; contact your equipment provider. See page
1-9 for contact information. Be sure to tell them all of the “symptoms” that your
microdispenser has displayed.

. The tray table doesn’t move when I press the microdispenser buttons [in

Manual Operation]. I hear a grinding noise.

The problem could be that the tray table has moved below the limit switch
(sensor). To readjust the tray table, access one of your Hydra DT files. Press Page
until you see one of the tray-table height parameters in the display. Press the Up
button several times to raise the tray table. Now the table will be above the sensor
and should work properly. If it doesn’t, the problem might be with the tray table
motor. A printed circuit board (PCB) problem or power supply problem is
possible. Do not attempt to fix a PCB or power supply problem; contact your
equipment provider. See page 1-9 for contact information. Be sure to tell them all
of the “symptoms” that your microdispenser has displayed.

. When I place a plate on the tray table/stage, the needles don’t line up
properly in the wells.

a. (On the Hydra DT base-unit system and Hydra DT with 3-Position XY Stage)
Probably you need to adjust the alignment of the tray table. Raise the tray
table so that the needles are close to the plate and you can see where the
needles align with the wells in the plate. (To move the tray table, you need to
access one of your Hydra DT files and adjust one of the tray-table height
parameters using the Up and Down buttons on the front of the Hydra DT case.

Troubleshooting and Tips
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See Chapter 3 for information on setting tray table heights.) Now use the
Allen wrench that came with the microdispenser to loosen the two screws
underneath the tray table. Loosen them one %2-counterclockwise turn so that
you can move the tray table slightly side to side. Loosen and tighten the two
screws to adjust the tray table position until you see that the needle tips are
aligned with the well centers. Then tighten the screws firmly, but do not
overtighten them.

b. (On the Hydra DT base-unit system and Hydra DT 3-Position XY Stage) If
you are using a manual plate positioner on a Hydra DT 96 model’s tray table,
the problem might be that you are not quite clicking the positioner into one of
its four positions. As you rotate the turnwheel on the positioner to move from
one position to the next, ensure that the positioner clicks into place for each
position.

c. On a Hydra DT with 3-Position X/Y Stage system, the stage or labware might
be miscalibrated. Recalibrate the stage or labware and then check the needle-
to-well-center alignment.

7. The syringe barrels are breaking frequently.

Probably the tips are coming in contact with the labware on the tray table/stage,
and the tips are becoming blocked. When that happens, pressure can build up in
the syringes and damage the syringes. If a syringe is damaged, immediately turn
off power to the system by pressing the Emergency Shutoff Switch. To fix the
problem of syringe barrels breaking frequently, try setting the tray table/stage
height so that the needle tips do not press into the lab-ware (microplate, reservoir,
etc.) on the tray table/stage. See page 6-9 for information about how to determine
the best dispense height for your application.

. When I use the microdispenser to transfer a small volume, the tips dispense

uneven amounts. I’ve been using the Aspirate with Overstroke/Dispense
Specific mode to fill the syringes with the solution to be transferred.

Use an aspirate-transfer protocol to transfer a small volume. You should always
include an air gap in an aspirate-transfer operation. To do an aspirate-transfer
operation, aspirate first an air gap and then the sample solution into the syringes.
Then use the Empty command [in Manual Operation] or the Dispense All
command [in Automated Operation] to empty the solution into the destination
plate. This procedure will give you more precise results for an aspirate-transfer
than a protocol that uses the Aspirate with Overstroke/Dispense Specific mode to
transfer a small volume. For details on why you should use the Aspirate with Pre
Air Gap/Dispense All mode for small-volume transfers, see page 6-5.
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The seal on the PTFE tips appears to be damaged. I can see liquid creeping
up the inside of the barrel above the tips.

The PTFE tips probably need to be replaced. See “Checking the PTFE Tips” on
page 5-4. If the tips are worn out, you should replace all of them.

One or more syringes are not dispensing properly.

a. If the syringes are dispensing uneven volumes, then the problem might be that
the PTFE tips are wearing out and should be replaced. See “Checking the
PTFE Tips” on page 5-4.

b. If the problem is not worn-out PTFE tips, then one or more syringes might be
damaged. Do a careful visual check for any broken or cracked syringes. If you
find any damaged syringes, replace them. See the procedure for replacing
syringes on page 5-7. If you don’t see any damaged syringes, go on to Step c.

c. Follow these Cautions:

é Caution: Put on safety glasses and gloves before you check for

11.

12.

13.

damaged syringes.

Use one of the following tests for syringe damage: (1) dispense dye into a plate
and see if some of the syringes do not dispense, or (2) dispense a microliter of
distilled water into the air and see if a bead forms on the ends of the tips. If a bead
doesn’t form on the end of a tips, then that particular syringe is damaged and
needs to be replaced. If any of the syringes are damaged, replace them. See the
procedure for replacing syringes on page 5-7.

When the microdispenser is doing a dry-plate dispense, some of the wells
aren’t receiving any sample.

The dispense height might need to be reset. See page 6-9 for information about
setting dispense heights to dispense onto dry plates.

I need to replace some syringes.

See Section 5-7 of the Hydra DT User Manual. This section details the necessary
steps for replacing Hydra DT syringes as well as removing the pipetting head for
return to the Matrix Technical Service Department.

Air is aspirating into the syringes along with the sample solution.

Either the height of the tray table/stage is too low or the microplate wells don’t
contain enough solution for the needle tips to be submerged when aspiration takes
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place. Adjust the height of the tray table/stage or the volume in the well as
needed.
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Quick Tips for Using the Hydra DT Microdispenser

The following tips provide answers to some frequently asked questions about using

and maintaining the microdispenser.

Table 8-2: Quick Tips for Using the Hydra DT Microdispenser

How dol ...

See ...

Use the unit safely?

Warnings and Cautions on page ix

Change the syringe size on the
microdispenser?

Contact your equipment provider. See page 1-9 for contact
information.

Find the firmware version for the system?

Note about Firmware Version on page 3-9

Keep needle tips from touching the tray
table/ stage?

“Set the tray table/stage height” on page 3-7

Create an air gap in the syringes?

“Priming Syringes in Aspirate with Pre Air Gap/Dispense All
Mode” on page 6-9

Keep the microdispenser in good working
order?

Chapter 6, Service and Maintenance of the Hydra DT
Microdispenser

Send the unit in for repair?

Warranty on page 1

Know when to change PTFE tips?

“Checking the PTFE Tips” on page 5-4

Change a broken syringe?

“Replacing Syringes” on page 5-7

Connect the microdispenser to a computer
so that functions can be controlled through
an RS-232 port using an ASC bi-directional
communications protocol?

Appendix D, Integrating the Hydra DT Microdispenser Into
an Automated Laboratory
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